
10 OpenClinica Installation and Upgrade
Guides
OpenClinica Community Edition can be installed on a computer/server running either a Linux or
Windows operating system. This chapter includes procedures to install the OpenClinica Community
Edition as a new application, as well as upgrade from a version of OpenClinica that was previously
installed.

Post any questions to the OpenClinica Forums.
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10.1 System Requirements
OpenClinica has a flexible architecture that can run on numerous infrastructure
combinations. General system recommendations are as follows:

Single server environment hardware recommendation (OpenClinica and PostgreSQL Databases
reside on the same server):

Minimum:
Linux (RedHat 6/7.x or CentOS 6/7.x)
CPU: Quad core 2GHz+ CPU
RAM: 4GB
Disk space: 100GB

Recommended:
Linux (RedHat 6/7x or CentOS 6/7.x)
CPU: Quad core 2GHz+ CPU
RAM: 16GB
Disk space: 500GB

Multiple-server environment hardware recommendation (OpenClinica and PostgreSQL Databases
reside on separate servers)

Minimum:
Linux (RedHat 6/7.x or CentOS 6/7.x)
CPU: Quad core 2GHz+ CPU
RAM: 2GB (OpenClinica), 2GB (PostgreSQL/Database)
Disk space: 100GB

https://www.openclinica.com/forums


Recommended:
Linux (RedHat 6/7.x or CentOS 6/7.x)
CPU: Quad core 2GHz+ CPU
RAM: 8GB (OpenClinica), 4GB (PostgreSQL/Database)
Disk space: 500GB

Recent production versions of OpenClinica have been verified to run on the following components:

Version Server OS Database Application
Server Language Memory Disk Client

Browser

3.10 -
3.14

RHEL/CentOS 
6/7.x  or above 
64-bit
(recommended)
Windows
2012, 
R2 or above
64-bit
Windows
2008, 
64-bit

Postgres 9.5.x
(recommended)
Postgres 8.4

Apache Tomcat
7.0.x JDK 7 2GB 20GB

IE 11+
Firefox
30.0+

3.6 -
3.9

RHEL/CentOS 
6.5  or above 
64-bit
(recommended)
Ubuntu 12.04 
LTS
64-bit
Windows
2012, 
R2 or above
64-bit
Windows
2008, 
64-bit

Postgres 8.4 Apache Tomcat
7.0.x JDK 7 2 GB 20GB

IE 11+
Firefox
30.0+

3.4, 3.5

RHEL/CentOS 
6.5  or above 
64-bit
(recommended)
Ubuntu 12.04 
LTS
64-bit
Windows
2012, 
R2 or above
64-bit
Windows
2008, 
64-bit
Windows 2003
R2 or above
32-bit
(not
recommended)

Postgres 8.4 Apache Tomcat
7.0.x JDK 7 2 GB 2 GB

IE 11+
Firefox
30.0



3.3

RHEL/CentOS 
6.5  or above 
64-bit
(recommended)
Windows 2003
R2 or above
32-bit
Ubuntu 12.04 
LTS
64-bit

Postgres 8.4 Apache Tomcat
7.0.x JDK 7 2 GB 2 GB

IE 11+
Firefox
25.01

3.2

Windows 2003
R2
CentOS 6.5
(~Red Hat
Enterprise
Linux 6.4)
Ubuntu 12.04
LTS

Postgres 8.4
Apache Jakarta
Tomcat 6.0.32
or 7.0.42
(recommended)

JDK 6 or JDK 7
(recommended)

256 MB
minimum
2 GB
recommended

500 MB
minimum
2 GB
recommended

IE 11
Firefox
25

3.1

Windows 2003
Red Hat
Enterprise
Linux 4.0
CentOS
Ubuntu

Postgres 8.4
(recommended)
Oracle 10g

Apache Jakarta
Tomcat 6.0.32 JDK 6

256 MB
minimum
2 GB
recommended

500 MB
minimum
2 GB
recommended

IE 7 or
8
Firefox
3.0+
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10.2 Install OpenClinica
Please go to our github wiki for instructions: https://github.com/OpenClinica/OpenClinica/wiki
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10.3 Install OpenClinica 3.4
To install on linux please follow the instructions
here: https://github.com/OpenClinica/OpenClinica/wiki/Install-OpenClinica-3.4-on-Linux
To install on windows please follow the instructions
here: https://github.com/OpenClinica/OpenClinica/wiki/Install-OpenClinica-3.4-on-Windows

Approved for publication by Kkrumlian Kkrumlian. Signed on 2014-10-10 2:19PM

Not valid unless obtained from the OpenClinica document management system on the day of
use.
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10.4 Install OpenClinica 3.3 on Linux
The recommended and tested platform is RHEL/CentOS 6.5

These instructions are for installing version 3.3 of OpenClinica, and also apply to installing the
maintenance releases of 3.3 for example 3.3.1. When you see v.x or v.x.y in the instructions, use your
version number, e.g. 3.3.1.

Overview of Installation on Linux Systems
Use the following process to acquire, install, and configure OpenClinca and its software
dependencies. In each step, click the link to view detailed instructions for that step:

Ensure your operating system meets the specified requirements1.
Download the installation files2.
Install Java3.
Install Tomcat4.
Install PostgreSQL database5.
Set up the PostgreSQL database6.
Deploy OpenClinica within Tomcat7.
Set Tomcat to start8.
Configure the OpenClinica application9.
Restart the system and verify access to OpenClinica10.
Configure Tomcat to use HTTPS11.
Verify the installation by ensuring you can log in to OpenClinica.12.

After completing the OpenClinica installation, see the Overview of OpenClinica for instructions to
start using the application. A good first step is to define one or more users (especially a Study
Director) and then build a Study.

 

Operating System Requirements
The following packages should be installed for your Operating System:

vim
unzip
tar

You require "root" user access. Run all commands in the installation instructions using root-level
permission.

 

Download Installation Files
OpenClinica and OpenClinica Web Services run and depend on several external software
technologies: the Java Development Kit, the Apache Tomcat Servlet Container, and the PostgreSQL
relational database

https://docs.openclinica.com/3.1/openclinica-user-guide/overview-openclinica


The OpenClinica website has a copy of the neccessary installers for Java, Tomcat, and PostgreSQL
for you to download. If you choose to use versions of Java, Tomcat, and PostgreSQL other than those
provided on the website, please note that they have not been tested with the OpenClinica
application. 

There are 32-bit and 64-bit editions of the software, when applicable. To determine if your system is
running a 32-bit or 64-bit operating system, in your Linux terminal, run

uname -a

The display reports the version:

If i386 or i686 displays, it is a 32-bit operating system.
If x86_64 displays, it is a 64-bit operating system.  (Recommended)

To download the installation files:

Run the following commands to create the OpenClinica directory on your system and to make1.
it the current directory:

mkdir -p /usr/local/oc/install
cd /usr/local/oc/install
Run the following commands to download the Java, Tomcat, and PostgreSQL files for your2.
architecture. In the commands, substitute v.x with the version of OpenClinica you are
installing ( e.g. 3.1):

For 32-bit operating systems, to get the files from OpenClinica run:

Apache Tomcat:  https://openclinica.app.box.com/oc-downloads/1/2186656927

JDK and Postgres:
https://openclinica.app.box.com/oc-downloads/1/2186650849
For 64-bit operating systems, to get the files from OpenClinca, run:

Apache Tomcat: https://openclinica.app.box.com/oc-downloads/1/2186656927
JDK and Postgres:
https://openclinica.app.box.com/oc-downloads/1/2186651363
Instead of downloading the files from the above links, you can download them directly
from their native websites but those versions may not be explicited tested to work with
OpenClinica:

PostgreSQL:http://www.postgresql.org/

Java:http://www.oracle.com/technetwork/java/index.html

Tomcat:http://tomcat.apache.org/

Download the OpenClinica software from the OpenClinica website, using this3.
location:https://community.openclinica.com/project/openclinica. To download the software, you
need an OpenClinica community user account, which is free to create; you will be required to
log in to the account to download the OpenClinica software.

https://openclinica.app.box.com/oc-downloads/1/2186650849
https://openclinica.app.box.com/oc-downloads/1/2186650849
https://openclinica.app.box.com/oc-downloads/1/2186650849
https://openclinica.app.box.com/oc-downloads/1/2186651363
http://www.postgresql.org/
http://www.oracle.com/technetwork/java/index.html
http://tomcat.apache.org/
https://community.openclinica.com/project/openclinica
https://community.openclinica.com/user/register


After downloading the OpenClinica software, move it to the directory where you downloaded
the other software components to:

/usr/local/oc/install

 

Install Java
The OpenClinica software is written in the Java programming language, so you must have Java
installed on your system in order to run the OpenClinica application.

The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

cd /usr/local/oc/install

Install Java by running:2.

tar -zxvf jdk-7*

Install Java in the operating system by running:3.

mv jdk1* /usr/local/
ln -s /usr/local/jdk1* /usr/local/java

Java is now installed in the correct location.

 

Install Tomcat
The OpenClinica software uses the Apache Tomcat Java application server.

The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

cd /usr/local/oc/install

Install Tomcat by running the following:2.

tar -zxvf apache-tomcat-*
mv apache-tomcat-* /usr/local/
ln -s /usr/local/apache-tomcat-7.0.52 /usr/local/tomcat
/usr/sbin/adduser tomcat

Move the web apps provided with Tomcat that are not needed by OpenClinica to another3.
location by running:

mkdir /usr/local/tomcat/oldwebapps

http://tomcat.apache.org/


mv /usr/local/tomcat/webapps/* /usr/local/tomcat/oldwebapps

Tomcat is now installed.

 

Install PostgreSQL Database
The OpenClinica software uses PostgreSQL as an underlying relational database management
system. Complete these instructions to install the PostgreSQL database.

The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

cd /usr/local/oc/install

Start the PostgreSQL setup by running:2.

chmod a+x postgresql-8.4.*
./postgresql-8.4.* --mode text

The PostgreSQL Setup Wizard starts.

For most of the options in the Setup Wizard, accept the defaults. Complete the Setup Wizard3.
as follows:

Prompt Action
Installation Directory [/opt/PostgreSQL/8.4] Press Enter to accept.
Data Directory [/opt/PostgreSQL/8.4/data] Press Enter to accept.

Password
Enter a password for the PostgreSQL
database superuser, then press Enter.
Record the password because you will
need it again in this installation.

Retype Password Type the password again, then
pressEnter.

Port [5432] Press Enter to accept.
Please choose an option [1] Press Enter to accept.
Install pl/pgsql in template1 database? [Y/n] Type n, then press Enter.
Do you want to continue? [Y/n] Press Enter to accept.
Setup has finished installing PostgreSQL on your
computer.

Stack Builder may be used to download and install
additional tools, drivers and applications to
complement your PostgreSQL installation. [Y/n]

Type n, then press Enter.

        

PostgreSQL is now installed on your system and will start when you start up your system.

 



Set Up the PostgreSQL Database
Complete these instructions to set up the PostgreSQL database. 

Run the following commands to create the PostgreSQL database and database user1.
OpenClinica uses to connect to the database:

/opt/PostgreSQL/8.4/bin/psql -U postgres -c "CREATE ROLE clinica LOGIN ENCRYPTED
PASSWORD 'clinica' SUPERUSER NOINHERIT NOCREATEDB NOCREATEROLE"

/opt/PostgreSQL/8.4/bin/psql -U postgres -c "CREATE DATABASE openclinica WITH
ENCODING='UTF8' OWNER=clinica"

The database user password is set to clinica by default, which is not a secure password.2.
Change the password as follows:

Run:1.

/opt/PostgreSQL/8.4/bin/psql -U postgres

A psql prompt displays with this message:2.

ALTER USER clinica WITH PASSWORD 'XXXX';

Replace XXXX with a secure password. Record the password for use in a later3.
installation step.

Exit the psql prompt by running:4.

q

 

Deploying OpenClinica within Tomcat
The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

cd /usr/local/oc/install

Run the following commands. In the commands, v.x is your version of OpenClinica, e.g. 3.2:2.

unzip OpenClinica-v.x*
cd OpenClinica-v.x*/distribution
unzip OpenClinica.war -d OpenClinica
cp -rf OpenClinica* /usr/local/tomcat/webapps

OpenClinica is now deployed for use with the database.

 



Deploying OpenClinica Web Services within Tomcat
Web Services are optional. Do not install them if you are not planning to use them.

The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

cd /usr/local/oc/install

Run the following commands. In the commands, v.x is your version of OpenClinica, e.g. 3.2:2.

unzip OpenClinica-ws-v.x*
cd OpenClinica-ws-v.x*/distribution
unzip OpenClinica-ws.war -d OpenClinica-ws
cp -rf OpenClinica* /usr/local/tomcat/webapps

OpenClinica web services are now deployed for use with the database.

 

Set Tomcat to Start
You can set Tomcat to automatically start when you start your system, or you can start and stop
Tomcat manually by issuing commands.

To set Tomcat to start automatically on system startup, run the following:

cp /usr/local/oc/install/OpenClinica-v.x*/install-docs/linux/tomcat /etc/init.d/

cd /etc/init.d

chmod a+x /etc/init.d/tomcat

/sbin/chkconfig --add tomcat (Note: This command is only for Red Hat Linux. For other operating
systems, see the operating system instructions for adding an init script.)

 

To stop and start Tomcat manually by issuing commands, run the following:

/usr/local/tomcat/bin/shutdown.sh (stops Tomcat)

/usr/local/tomcat/bin/startup.sh (starts Tomcat)

 

Configure OpenClinica for Optimum Performance
Under stress tests, OpenClinica 3.1.3 has performed well with the following JVM (Java Virtual
Machine) settings: 

Edit the init.d/tomcat and replace the JAVA_OPTS with following:



export JAVA_OPTS="$JAVA_OPTS   -Xmx1280m -XX:+UseParallelGC -XX:ParallelGCThreads=n -
XX:MaxPermSize=180m -XX:+CMSClassUnloadingEnabled"

For the setting -XX:ParallelGCThreads=n, n should be replaced with the # of cores of your CPU as
long as the total number of cores are lesser than 8.

The number of cores can be determined by using 'top' command.

Please note that the minimum RAM requirement is 1280 MB of memory for these settings, so the
server is expected to have much higher RAM available. The amount of available memory can be
determined by using the command free -m to give the memory (in MB). The MaxPermSize value
depends on the number of war files that you are deploying. The web war needs a 180m of PermGen
and the ws war needs a 90m of PermGen memory settings.

For the settings to take effect, restart the Tomcat server.

 

Configure the OpenClinica Application
If you followed all the previous instructions exactly, there is only one property in the configuration
file, datainfo.properties, that you may need to change in order for OpenClinica to start. There are
other properties in the configuration file you will probably want to modify for your system.

Open the configuration file: /usr/local/tomcat/webapps/OpenClinica/WEB-1.
INF/classes/datainfo.properties
Edit values for the properties in the datainfo.properties file. You must change the value2.
for dbPass to the password you selected in Set Up the PostgreSQL Database. Change the
values for any other properties, then save the file.
Update the filePath parameter to the right value.3.
Run the following commands:4.

chown -R tomcat /usr/local/tomcat/*
chown -R tomcat /usr/local/apache-*
You may also need to configure OpenClinica for internationalization should you wish to utilize5.
OpenClinica in different languages. Also, if you need to use some UTF-8 characters in your
application, you may need to modify your default connecter configuration. For more
information regarding configuring OpenClinica for internationalization and using UTF-8
characters, please refer to
 https://docs.openclinica.com/3.1/technical-documents/openclinica-and-internationalization

 

Configure the OpenClinica Web Services
If you followed all the previous instructions exactly, there is only one property in the configuration
file, datainfo.properties, that you may need to change in order for OpenClinica Web Services to
start. There are other properties in the configuration file you will probably want to modify for your
system.

Note: Most of the properties are not needed or used for Web Services, see Description of

https://docs.openclinica.com/3-1/installation/3-1-installation-install-3-1-x-linux/3-1-installation-installation-linux-download-installation-files/#content-title-4337#content-title-5457#content-title-5457#content-title-5457%20#content-title-5457#content-title-5457%20#content-title-4343%20#content-title-4343%20#content-title-4343%20#content-title-4343%20#content-title-5457%20#content-title-4342#content-title-4343%20#content-title-4343%20#content-title-4343%20
https://docs.openclinica.com/3.1/technical-documents/openclinica-and-internationalization
https://docs.openclinica.com/3-1/installation/3-1-installation-install-3-1-x-linux/3-1-installation-installation-linux-download-installation-files/#content-title-4337#content-title-5457#content-title-5457#content-title-5457%20#content-title-5457#content-title-5457%20#content-title-4343%20#content-title-4343%20#content-title-4343%20#content-title-4343%20#content-title-5457%20#content-title-4342#content-title-4343%20#content-title-4343%20#content-title-4343%20#content-title-5457


datainfo.properties File for Web Services for more information on what settings are actually used.

Open the configuration file: /usr/local/tomcat/webapps/OpenClinica-ws/WEB-1.
INF/classes/datainfo.properties
Edit values for the properties in the datainfo.properties file. You must change all values from2.
Database Configuration section of datainfo.properties file to reflect your settings in
datainfo.properties file for OpenClinica application. Change the values for any other
properties. 
Run the following commands:3.

chown -R tomcat /usr/local/tomcat/*
chown -R tomcat /usr/local/apache-*

 

Verify Access to OpenClinica

At this point, Java, Tomcat, PostgreSQL, and OpenClinica are installed and set up. Restart the
system by running:

reboot

Strictly speaking,  rebooting is not necessary but ensures that all the relevant services are setup
correctly to start on boot. After the system starts up, access OpenClinica at the following URL:

http://localhost:8080/OpenClinica

The Log In page should display.

To verify your set-up, try to access OpenClinica from another computer by running the same
command from that computer, but replace localhost with the server's IP or hostname.

 

Verify Access to OpenClinica Web Services
Access OpenClinica Web Services at the following URL:

http://localhost:8080/OpenClinica-ws

The Welcome page should display.

To verify your set-up, try to access OpenClinica Web Services from another computer by running the
same command from that computer, but replace localhost with the server's IP or hostname.

 

Configure Tomcat to Use HTTPS
OpenClinica strongly recommends securing the Tomcat application server using a Secure Socket
Layer protocol (SSL). SSL is a data transport encryption technology used to make



secure https:// connections. SSL requires a third-party security certificate to be effective.
Information about configuring SSL certificates for Tomcat is at this
website: http://tomcat.apache.org/tomcat-6.0-doc/ssl-howto.html.

 

Verify the Installation
Log in to OpenClinica with the username root and the password 12345678. OpenClinica requires you
to change the password for the user "root" to a secure password. See Update User Profile if you
need more information.

The user "root" is assigned to the Study "Default". Create a user account login for yourself, with the
User Type set to "technical administrator" and the User Role set to Data Manager. For instructions
to create the user account, see Create a New User.

Approved for publication by Thasbiha Khaja. Signed on 2014-08-12 1:17PM
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10.5 Install OpenClinica 3.3 on Windows
These installation instructions have been verified on the following Windows operating systems
versions:

Windows Server 2003 Standard Edition SP2
Windows Server 2003 Standard Edition SP1

Please note that all these instructions require Administrator-level permissions.

These instructions are for installing version 3.3 of OpenClinica. Screenshots shown in these
instructions might look different than the screens on your system because your operating system
might not be exactly the same. For the same reason, your screenshots might not correspond exactly
with those in the written instructions. Where the screenshot differs from the written instruction,
always follow the written instruction.

All characters in the installation commands are case sensitive. Also note that any additional white
space between or after characters in commands could cause installation errors.

9.3.1 Overview of Installation on Windows Systems
Use the following process to acquire, install, and configure OpenClinca and its software
dependencies. In each step, click the link to view detailed instructions for that step:

9.3.2 Ensure your system complies with software dependencies and operating system
requirements.
9.3.3 Install Java
9.3.4 Install PostgreSQL
9.3.5 Install Tomcat

http://tomcat.apache.org/tomcat-6.0-doc/ssl-howto.html
https://docs.openclinica.com/3.1/openclinica-user-guide/working-openclinica#content-title-3603
https://docs.openclinica.com/3.1/administer-users#content-title-2979


9.3.6 Starting and Stopping Tomcat
9.3.7 Set Up the PostgreSQL Database
9.3.8 Configure Tomcat to Work with OpenClinica and OpenClinica Web Services
9.3.9 Configure the OpenClinica Installation
9.3.10 Verify the Installation
9.3.11 Install OpenClinica Web Services Package
9.3.12 Configure OpenClinica Web Services
9.3.13 Verify the Installation of OpenClinica Web Services

After completing the OpenClinica installation, see the Overview of OpenClinica for instructions to
start using the application. A good first step is to define one or more users (especially a Study
Director), and then build a Study.

9.3.2 Software Dependencies and Operating System Requirements

Windows Configuration
Your Windows operating system must be configured to show file extensions by default. To configure
this behavior:
1. Open a Windows Explorer window.
2. Select Tools > Folder Options.
3. Click the View tab.
4. In Advanced settings, clear the Hide extensions for known file types checkbox.
5. Click Apply.

Software Dependencies
OpenClinica runs on any Servlet/JSP container that implements the Servlet 2.4 and JavaServer Pages
2.0 specifications from the Java Community Process. OpenClinica was developed to run on and has
been tested with Apache Tomcat 7.0.52.

OpenClinica runs on the PostgreSQL relational database. Using a
JDBC (Java Database Connectivity) driver, the database connects to the OpenClinica web application
and provides the data to the user.

New installations require the following software dependencies, all of which are open source. These
installation instructions walk through the process of downloading, installing, and configuring them
for use with OpenClinica.

Java 7 Standard Edition Development Kit 7.0 update 52 (Note: Java frequently changes its
naming conventions.)
Tomcat 7.0.52
PostgreSQL 8.4.7.2

Other Versions of Dependent Software
The software dependencies OpenClinica uses are frequently updated with minor versions and
revisions. Sometimes only a matter of weeks separates the release of two adjacent versions. In some
cases, the particular revision number used may no longer be available. In general, you should be
able to use more recent minor versions and revisions of the software dependencies. For example, if
the installation instructions refer to PostgreSQL 8.4.7.2, then PostgreSQL 8.4.8 should work
successfully too (but not PostgreSQL 9).
Record the version or revision number of all the software you use. If you have concerns about a
particular combination, post your question to the OpenClinica Forums.

https://www.openclinica.com/forums


9.3.3 Install Java

The OpenClinica software is written in the Java programming language, so you must have Java
installed on your system in order to run the OpenClinica application. Follow these instructions to
install Java:

OpenClinica 3.3 is designed to run on a Java 7 SDK platform. To avoid conflicts with other1.
versions of Java, clear out any other Java installations on the system. Select Start > Control
Panel > Add Remove Programs, then remove any Java JREs and SDKs.
Create the directory c:ocinstall.2.
From one of the following websites, download the Java 7 SE Development Kit 7.0 update 523.
(jdk-7u51-windows-i586.exe ) into c:ocinstall:

From the Java website:
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html

4. Run c:ocinstalljdk-7u51-windows-i586.exe.

5. The Open File - Security Warning message displays.

6. Click Run.
The Welcome to Java Installation Wizard opens.
7. Click Next.
The Custom Setup screen displays.
8. Click Change....
9. Change the path to c:oc jdk1.7.0_51, then click OK.
The Custom Setup screen should now look like this:

10. Click Next.
The Setup Wizard installs the JDK. When setup completes, a screen to install JRE7 displays.
11. Click Cancel, and then in the confirmation dialog box click Yes.

http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html


The Install Success screen displays.
12. Click Close.
13. A web browser window opens, presenting you with the option to register the JDK. Register, or
close the window.

9.3.4 Install PostgreSQL Database

The OpenClinica software uses the PostgreSQL relational database management system.  Complete
these instructions to install PostgreSQL.

From this location1.
http://www.enterprisedb.com/postgresql-8421-installers-win32?ls=Crossover&type=Crossover
, download the executable to c:ocinstall.
Run the executable2.
The Open File Security Warning message displays
Click Run.3.
The PostgreSQL Installation Wizard opens.
Click Next.4.
The Installation directory screen displays.
Click Next to accept the default values.5.
The Data directory screen displays.
Click Next to accept the default values.6.
The Password screen displays.
Enter a password for the Postgres superuser. Record the password for use later in the7.
installation process. Re-enter the password, and click Next.
The Port screen displays.
Click Next to accept the default value (5432).8.
The Advanced Options screen displays.

Complete the screen as follows:9.
1. For Locale, select Default locale.
2. Clear the Install pl/pgsql in template1 database? checkbox.
3. Click Next.



The Ready to install screen displays
Click Next to start the installation.10.
When the installation finishes, the Completing the PostgreSQL Setup Wizard screen
displays.
Clear the Launch Stackbuilder at exit checkbox, then click Finish.11.

9.3.5 Install Tomcat

From either of the following websites, download the Windows Service Installer Version,1.
apache-tomcat-7.0.52.exe, and save it to c:ocinstall:

From the Apache website: http://tomcat.apache.org/download-70.cgi

Run2.
c:ocinstall apache-tomcat-7.0.52.exe
The Apache Tomcat Setup Installation Wizard opens.
When the Open File - Security Warning message displays, click Run.3.
On the Welcome screen of the Apache Tomcat Setup Installation Wizard, click Next.4.
The License Agreement screen displays.
Click I Agree to accept the agreement.5.
The Choose Components screen displays.
Click Next to accept the default values.6.
The Configuration screen displays.
Click Next to accept the default values.7.
The Java Virtual Machine screen displays.
Click ..., then select the path you installed the JDK into:8.
c:oc jdk1.7.0_51
The screen now should look like this:

Click Next.9.
The Choose Install Location screen displays
Edit the Destination Folder to be c:octomcat. The screen should look like this:10.

http://tomcat.apache.org/download-70.cgi


Click Install to start the installation.11.
When the installation is finished, the Completing the Apache Tomcat Setup Wizard screen
displays.
Complete the screen as follows:12.
0. Clear the Run Apache Tomcat checkbox.
1. Clear the Show Readme checkbox.
The screen should now look like this:

Click Finish.13.
Create the directory c:octomcatoldwebapps.14.
Move the web apps provided with Tomcat that OpenClinica does not need by moving the15.



contents of c:octomcatwebapps to c:octomcatoldwebapps.

9.3.6 Starting and Stopping Tomcat

Start Tomcat using any one of these methods:

From the Apache Tomcat 7 Properties window:1.
Select Start > Apache Tomcat 7.0 > Configure Tomcat to open the window.1.
Click the General tab.2.
On the General page, click the Start button to start Tomcat.3.

Using the Windows run command:2.
Select Start > Run.1.
In the Run box, type cmd, then click OK.2.
At the new command prompt, start Tomcat by typing3.

net start tomcat7
then press Enter.

When you need to stop Tomcat, type
net stop tomcat7
then press Enter.

9.3.6 Install OpenClinica Package

Download the OpenClinica software, OpenClinica-v.x.y.zip, from the OpenClinica website1.
location, https://community.openclinica.com/project/openclinica. To download the software,
you need a community account, which is free to create. You will be required to log in to this
account to download the OpenClinica software.
After downloading the OpenClinica software, move it to the directory with the other software
dependencies you downloaded:
c:ocinstall.
Right-click OpenClinica-v.x.y.zip and select Extract All.2.
The Extraction Wizard opens.
Click Next.3.
In the next screen, change the directory to c:ocinstall, and click Next.4.
In the next screen, clear the Show Extracted Files checkbox, and click Finish.5.
Copy c:ocinstallOpenClinica-v.x.ydistributionOpenClinica.war to c:octomcatwebapps.6.

9.3.7 Set Up the PostgreSQL Database

Complete these instructions to setup PostgreSQL database.

Select Start > Programs > PostgreSQL 8.4 > pgAdminIII.1.
The pgAdminIII window opens. Right-click the PostgreSQL 8.4 (localhost:5432) icon, and2.
select Connect, as shown here:

https://community.openclinica.com/project/openclinica


Log in to the database server using the password you set up during the PostgreSQL3.
installation.
Create the database openclinica and the database user clinica, which OpenClinica uses to4.
connect to the database:
0. Expand the databases, and select postgreSQL.
1. Select Tools > Query tool.
The Query window opens.
2. In the SQL Editor box, delete all the text.
3. In the SQL Editor box, type the following:
CREATE ROLE clinica LOGIN ENCRYPTED PASSWORD 'clinica' SUPERUSER NOINHERIT
NOCREATEDB NOCREATEROLE;
4. Select Query > Execute, which runs the SQL query.
When the query completes, a message displays in the History window.
5. In the SQL Editor box, delete all the text.
6. In the SQL Editor box, type the following:
CREATE DATABASE openclinica WITH ENCODING='UTF8' OWNER=clinica;
7. Select Query > Execute.
When the query completes, a message displays in the History window.
8. Close the Query window, and click No when prompted to save changes.
The database password is set to clinica by default, which is not a secure password. Change the5.
password as follows:

In the pgAdminIII window, expand and select Login Roles.1.
Select View > Refresh.2.
The clinica database user is listed.3.
Right-click the clinica user account and select Properties.4.
In the Login Role for clinica box that displays, enter the new password and re-enter it,5.
then click OK.   Record the password for future use.

9.3.8 Configure Tomcat to Work with OpenClinica and (if installed) OpenClinica Web
Services

Select Start>All Programs > Apache Tomcat 7.0 > Configure Tomcat.1.



The Apache Tomcat 7 Properties window opens.
Please click the Java Options tab described in the 'Configure Tomcat' section and add the2.
following
-XX:+UseParallelGC
-XX:ParallelGCThreads=n
-XX:MaxPermSize=180m
-XX:+CMSClassUnloadingEnabled
 On Java Console set Maximum Pool Size to 1280.
Please note that the minimum RAM requirement is 1280 MB of memory for these settings, so
the CPU is expected to have much higher RAM available.
Where n is the number of cores of your CPU.  There should be no spaces before or after each
entry. Each entry should be on a new line. The MaxPermSize value depends on the number of
.war files that you are deploying. For instance, if you deploy web and web services,
XX:MaxPermSize should be set to 360m.
 -XX:ParallelGCThreads = # of cores of your CPU, as long as the number of processors on your
CPU are lesser than 8.The Window should look like this for a 4 core processor:
This setting is based upon the number of war files deployed. The web war needs a 180m of
PermGen and the ws war needs a 90m of PermGen memory settings.
The window should now look like this:3.

Click Apply, which completes the configuration of Tomcat.4.
Start Tomcat:5.

Click the General tab.1.
On the General page, click Start.2.

In about five minutes, Tomcat will be fully started. Verify it is fully started by opening the file6.
c:octomcatlogstomcat7-stderr.current date.out, and looking for this line:
INFO: Server Startup in XXXXX ms
After verifying Tomcat has fully started, in the General page of the Apache Tomcat 77.
Properties window, click Stop.



Wait two minutes for Tomcat to stop, then delete OpenClinca.war from c:octomcatwebapps.8.

9.3.9 Configure the OpenClinica Application

If you followed all the previous instructions exactly, there is only one property in the configuration
file, datainfo.properties, that you may need to change in order for OpenClinica to start. There are
other properties in the configuration file you will probably want to modify for your system, however.

Using WordPad, open the configuration file:1.
c:octomcatwebappsOpenClinicaWEB-INFclassesdatainfo.properties
Edit values for the properties in the datainfo.properties file. You must change the value for2.
dbPass to the password you selected when you set-up PostgreSQL. Change the values for any
other properties. The datainfo.properties file for Windows is the same as for Linux.
When you finish making changes, save the file.3.
You may also need to configure OpenClinica for internationalization should you wish to utilize4.
OpenClinica in different languages. Also, if you need to use some UTF-8 characters in your
application, you may need to modify your default connecter configuration. For more
information regarding configuring OpenClinica for internationalization and using UTF-8
characters, please refer to
https://docs.openclinica.com/3-1-technical-documents/openclinica-and-internationalization/.

9.3.10 Verify the Installation

At this point, Java, Tomcat, PostgreSQL, and OpenClinica are installed and set up. Verify the
installation was successful by following these steps:

Restart Tomcat1.
Open a web browser and access OpenClinica at the following URL:2.

http://localhost:8080/OpenClinica

(The port number may be different if you changed the configuration of your Tomcat instance
that is running OpenClinica.)  The OpenClinica Login page should display.
Log in to OpenClinica using the default user name, root, and password 12345678. You will be3.
forced to change the password for the user "root" to a secure password. See Update User
Profile if you need more information.
The user "root" is assigned to a default Study named "Default." Create a user account for4.
yourself, with the User Type set to "technical administrator" and the User Role set to Data
Manager: for instructions to create the user account, see Create a New User.
Log out and stop Tomcat if you now plan to install Web Services Package5.

9.3.11 Install OpenClinica Web Services Package

Web Services are optional. You do not need to install them if you are not planning on using web
services.

Download the OpenClinica-ws software, OpenClinica-ws-v.x.y.zip, from the OpenClinica1.
website location: https://community.openclinica.com/project/openclinica. To download the
software, you need a community account, which is free to create. You will be required to log in
to the account to download the OpenClinica software. After downloading the OpenClinica-ws
software, move it to the directory with the other software dependencies you downloaded:
c:ocinstall.

https://docs.openclinica.com/3-1/installation/3-1-installation-install-3-1-x-linux/3-1-installation-installation-linux-download-installation-files/#content-title-4337#content-title-5457#content-title-5457#content-title-5457%20#content-title-5457#content-title-5457%20#content-title-4343%20#content-title-4343%20#content-title-4343%20#content-title-4343%20#content-title-5457%20#content-title-4342#content-title-4343%20#content-title-4343%20
https://docs.openclinica.com/3-1-technical-documents/openclinica-and-internationalization/
https://docs.openclinica.com/3.1/openclinica-user-guide/working-openclinica#content-title-3603
https://docs.openclinica.com/3.1/openclinica-user-guide/working-openclinica#content-title-3603
https://docs.openclinica.com/3.1/administer-users#content-title-2979
https://community.openclinica.com/project/openclinica


Right-click OpenClinica-ws-v.x.y.zip and select Extract All.2.
The Extraction Wizard opens.3.
Click Next.4.
In the next screen, change the directory to c:ocinstall, and click Next.5.
In the next screen, clear the Show Extracted Files checkbox, and click Finish.6.
Copy c:ocinstallOpenClinica-ws-v.x.ydistributionOpenClinica-ws.war to c:octomcatwebapps.7.
Restart Tomcat then stop Tomcat following the intructions from above.8.

9.3.12 Configure OpenClinica Web Services

If you followed all the previous instructions exactly, there is only one property in the configuration
file, datainfo.properties, that you may need to change in order for OpenClinica Web Services to
start. There are other properties in the configuration file you will probably want to modify for your
system, however.
Note: Most of the properties are not needed or used for Web Services.

Using WordPad, open the configuration file:1.
c:octomcatwebappsOpenClinica-wsWEB-INFclassesdatainfo.properties
Edit values for the properties in the datainfo.properties file. You must change all values from2.
Database Configuration section of datainfo.properties file to reflect your settings in
datainfo.properties file for OpenClinica application. Change the values for any other
properties.

The datainfo.properties file for Windows is the same as for Linuxsee more information at
description of datainfo.properties file for web services.
If you are installing Web Services for OpenClinica 3.1.2 and earlier please edit adminEmail3.
property (section 5 - adminEmail) if you would like e-mail to be send through 'Contact' link
from Web Services welcome page.
Other properties that can be configured for web services are:4.
0. Section 11 - Logging configuration
When you finish making changes, save the file.5.

9.3.13 Verify the Installation of OpenClinica Web Services

Restart Tomcat1.
Point your web browser to the OpenClinica Web Services welcome page: http://<<server2.
url>>:8080/OpenClinica-ws. The OpenClinica Web Services Welcome page should be display.
Verify the version number is v.x.x-Community, where v.x.x is the version number you upgraded3.
OpenClinica Web Services to. The version number is displayed in the lower right corner of the
page.

Web Services should have the same version as OpenClinica application.
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10.6 Upgrade to OpenClinica 3.3 on Linux
The following process describes how to upgrade Java and Tomcat to work with OpenClinica 3.3 on
Linux. Be sure to back up your database before starting the upgrade process.

Before you begin, the following packages should be installed with your Linux operating system:
    vim
    unzip
    tar
(eg:~# yum install vim)

You will require "root" user access to your operating system. Run all commands in this guide with a
user account possessing root-level permissions.

9.3.1 Upgrade Java 6 to Java 7

9.3.1.1 Preconditions for Upgrading Java

Access OpenClinica at the following URL:1.
http://localhost:8080/OpenClinica
The Login page should display.

Verify the current version of Java is Java 6 by running this command:2.

/usr/local/java/jre/bin/java version

 9.3.1.2 Upgrade Java 6 to Java 7

a. For 32-bit operating systems, to get the files from OpenClinica, run:

    wget https://dev.openclinica.com/oc/software/OpenClinica-3.2/linux/jdk-7u51-linux-i586.gz

b. For 64-bit operating systems, to get the files from OpenClinca, run:

    wget https://dev.openclinica.com/oc/software/OpenClinica-3.2/linux/jdk-7u51-linux-x64.gz

The OpenClinica software is written in the Java programming language, so you must have Java
installed on your system in order to run the OpenClinica application.

Install Java by running:1.

tar -xvf jdk-7u51-linux-x64.tar.gz     

chown R root:root jdk1.7.0_51

chmod a+x jdk-7*     

 To install the Java in operating system by running2.
        



mv jdk1.7* /usr/local/
        
ln -s /usr/local/jdk1.7* /usr/local/java

Java is now installed in the correct location. 

9.3.1.3 Verify Java 7 is installed

Verify the current version of the Java is Java 7 by running these commands in root:1.
/usr/local/java/jre/bin/java version2.
Access OpenClinica at the following URL:3.
http://localhost:8080/OpenClinica
The Login page should display.

 9.3.2 Upgrade Tomcat 6 to Tomcat 7

9.3.2.1 Preconditions for Upgrading Tomcat

Access OpenClinica at the following URL:1.
http://localhost:8080/OpenClinica
The Login page should display.
Stop Tomcat 6 by running the following command:2.

service tomcat stop
Uninstall Tomcat 6 from your system (including all the configuration files).3.

rm i /usr/local/tomcat

rm irf /usr/local/apache-tomcat-6.0.32

9.3.2.2 Install Tomcat 7

The OpenClinica software uses the Apache Tomcat Java application server.1.
Download Tomcat 7 from one of the following sites and copy it into the local folder
/usr/local/oc/install/
Download it from the Tomcat website: http://tomcat.apache.org/download-70.cgi
- or -
Download it from the OpenClinica website: 
https://dev.openclinica.com/oc/software/OpenClinica-3.2/linux/apache-tomcat-7.0.5
2.tar.gz
Run the following command in /usr/local/oc/install/ to install Tomcat 7.
wget
https://dev.openclinica.com/oc/software/OpenClinica-3.2/linux/apache-tomcat-7.0.5
2.tar.gz
The current directory on your system should be /usr/local/oc/install. If it is not,2.
make it the current directory by running:
cd /usr/local/oc/install
Install Tomcat by running the following:3.

tar -xvf apache-tomcat-7*

http://tomcat.apache.org/download-70.cgi
https://dev.openclinica.com/oc/software/OpenClinica-3.2/linux/apache-tomcat-7.0.52.tar.gz
https://dev.openclinica.com/oc/software/OpenClinica-3.2/linux/apache-tomcat-7.0.52.tar.gz


mv apache-tomcat-7.0.52 /usr/local/

ln -s /usr/local/apache-tomcat-7.0.52 /usr/local/tomcat

(Note: The system will prompt you to enter your UNIX password. Use tomcat as
the password, and press enter for all the default value for the full name, room
number, phone, home phone and other. Is the info correct? Type Y and enter.)
Move the web apps provided with Tomcat that are not needed by OpenClinica to4.
another location by running:

mkdir /usr/local/tomcat/oldwebapps

mv /usr/local/tomcat/webapps/* /usr/local/tomcat/oldwebapps

Tomcat is now installed and you can set Tomcat to automatically start when you
start your system, or you can start Tomcat manually by issuing commands.

To set Tomcat to start automatically on system startup, run the following: (Note:
Before running the command install the OpenClinica 3.3 on your install folder)

cp /usr/local/oc/install/OpenClinica-3.3*/install-docs/linux/tomcat /etc/init.d/

chmod a+x /etc/init.d/tomcat

/sbin/chkconfig --add tomcat

(Note: This command is only for Red Hat Linux. For other operating systems, see
the operating system instructions for adding an init script.)

Update the File Path parameter to the correct value5.

chown -R tomcat /usr/local/tomcat/*

chown -R tomcat /usr/local/apache-*

9.3.2.3 Deploy the OpenClinica Software Package

Download the OpenClinica software package, OpenClinica 3.3.tar.gz, from the
OpenClinica website: https://community.openclinica.com/project/openclinica. To
download the software, you need a community account, which is free to create. You will
be required to log in to the account in order to download the OpenClinica software.

        First, make sure Tomcat is stopped:

Stop Tomcat 7 by running:1.
service tomcat stop
The current directory on your system should be /usr/local/oc/install. If it is not,2.
make it the current directory by running:
cd /usr/local/oc/install
Run each of the following commands:3.

https://docs.openclinica.com/install-3-2-linux
https://community.openclinica.com/project/openclinica
https://www.openclinica.com/cas/login?service=https://community.openclinica.com/cas?destination=https://www.openclinica.com/


unzip OpenClinica 3.3*

cd OpenClinica 3.3*/distribution

unzip OpenClinica.war -d OpenClinica

cp -rf OpenClinica* /usr/local/tomcat/webapps

rm -f /usr/local/tomcat/webapps/OpenClinica

OpenClinica is now deployed for use with the database.

9.3.2.4 Verify Tomcat 7 is Started and the Application is Running

Start Tomcat:1.
service tomcat start
(Note: Replace start with stop to stop the Tomcat service)
Verify Tomcat 7 is running with the following commands. You should see a similar2.
message as shown in the bracket().
service tomcat status  (Tomcat is running)
Access OpenClinica at the following URL:3.
http://localhost:8080/OpenClinica
The Login page should display.
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10.7 Upgrade to OpenClinica 3.3 on Windows
9.4.1 Upgrade Java 6 to Java 7

9.4.1.1 Preconditions for Upgrading Java

Verify Java 6 (jdk1.6.0_24) is already installed and running.1.
Go to Start>All Programs>Java Folder. Click About Java.
Verify the current version of Java is 6 (jdk1.6.0_24).
Verify the following directory exists c:ocinstall. If it does not, then create the directory.2.
Open a web browser and access OpenClinica at the following URL:3.
http://localhost:8080/OpenClinica
The OpenClinica login page should display.

9.4.1.2 Upgrade Java 6 to Java 7



From one of the following websites, download the Java 7 SE Development Kit 7.0 update1.
(jdk-7u51-windows-i586.exe ) and save it to c:ocinstall:

From the Java website:
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.htm
l
From the OpenClinica website:
http://svn.akazaresearch.com/oc/software/OpenClinica-3.2/windows/

Run c:ocinstalljdk-7u51-windows-i586.exe.2.
The installation window starts and looks like:3.

Click Next4.
The Custom Setup screen displays.5.
a. Click Change....
b. Change the path to c:oc jdk1.7.0_51, then click OK.
The Custom Setup screen should now look like this:

Click Next6.
Java Setup-Destination Folder will show up. Keep the default location and click Next7.
The Setup Wizard installs the JDK.8.

http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html
http://svn.akazaresearch.com/oc/software/OpenClinica-3.2/windows/


The Install Success screen displays.9.
Click Close.10.

9.4.1.3 Verify Java 7 is installed

Verify Java 7 (jdk1.7.0_51) has been installed and running. Also, please notice that all1.
applications, not specified with Java 6, will use Java 7 after the upgrading.
Go to Start>All Programs>Java Folder. Click About Java.
Verify the current version of Java is 7 (jdk1.7.0_51). The updated About Java screen should
look as below:

Verify Java 7 is installed by opening a web browser and accessing OpenClinica at the following URL:
http://localhost:8080/OpenClinica
The OpenClinica login page should display

9.4.2 Upgrade Tomcat6 to Tomcat7

9.4.2.1 Preconditions for Upgrading Tomcat

First, open a web browser and verify you can access OpenClinica at the following1.
URL: http://localhost:8080/OpenClinica
The OpenClinica login page should display.
To upgrade the Tomcat 6 to Tomcat 7, you need to first remove Tomcat 6:2.

Stop Tomcat 6 using any one of these methods:

From the Apache Tomcat 6 Properties window:1.
Select Start > Apache Tomcat 6.0 > Configure Tomcat to open the
window.
Click the General tab.
On the General page, click the Stop button to stop Tomcat

Using the Windows run command:2.
Select Start > Run.
In the Run box, type cmd, then click OK.

At the new command prompt, stop Tomcat by typing



net stop tomcat6

Then press Enter.

a. Uninstall Tomcat 6
Select Start > Control Panel > Add Remove Programs, then remove Tomcat 6 by pressing
uninstall program.

b. Reboot the system

After removing the Tomcat6 from the program, reboot the system.

9.4.2.2 Install Tomcat 7

From either of the following two websites, download the Windows Service Installer1.
Version, apache-tomcat-7.0.52.exe, and save it to c:ocinstall:

Download from the Apache website: http://tomcat.apache.org/download-70.cgi
Download from the OpenClinica website:
http://svn.akazaresearch.com/oc/software/OpenClinica-3.3/windows/

Run the Installation file:2.
c:ocinstallapache-tomcat-7.0.52.exe
The Apache Tomcat Setup Installation Wizard opens.
When the Open File - Security Warning message displays, click Run.
On the Welcome screen of the Apache Tomcat Setup Installation Wizard, click
Next.
The License Agreement screen displays. Click I Agree to accept the agreement.
The Choose Components screen displays. Click Next to accept the default values.
The Configuration screen displays. Click Next to accept the default values.
The Java Virtual Machine screen displays. Click ..., then select the path where you
installed the JDK:
c:oc jdk1.7.0_51
The screen now should look like this:

http://tomcat.apache.org/download-70.cgi
http://svn.akazaresearch.com/oc/software/OpenClinica-3.2/windows/


Click Next.

The Choose Install Location screen displays. Edit the Destination Folder
to be c:octomcat. The screen should look like this:

Click Install to start the installation.
When the installation is finished, the Completing the Apache Tomcat
Setup Wizard screen displays.Complete the screen as follows:



-Clear the Run Apache Tomcat checkbox.
-Clear the Show Readme checkbox.
The screen should now look like this:

Click Finish.

9.4.2.3 Deploy the OpenClinica Package

Download the OpenClinica software package, OpenClinica 3.3.zip, from the1.
OpenClinica website: https://community.openclinica.com/project/openclinica. To
download the software, you need a community account, which is free to create.
You will be required to log in to the account in order to download the OpenClinica
software.

After downloading the OpenClinica software, move it to the directory with
the other software dependencies you downloaded:
c:ocinstall.

Right-click OpenClinica 3.3.zip and select Extract All.1.
The Extraction Wizard opens.
Click Next2.
In the next screen, change the directory to c:ocinstall, and click Next.3.
In the next screen, clear the Show Extracted Files checkbox, and click Finish.4.
Stop Tomcat. At the new command prompt, stop Tomcat by typing:5.
net stop tomcat7
Copy c:ocinstallOpenClinica 3.3distributionOpenClinica.war to6.
c:octomcatwebapps.

https://community.openclinica.com/project/openclinica
https://www.openclinica.com/cas/login?service=https://community.openclinica.com/cas?destination=https://www.openclinica.com/


9.4.2.4 Verify Tomcat 7 is installed and Application is Running

a. Start Tomcat

Verify that Tomcat is running. If Tomcat is not started than start Tomcat
using any one of these methods:

From the Apache Tomcat 7Properties window:1.
Select Start > Apache Tomcat 7.0 > Configure Tomcat to
open the window.
Click the General tab.
On the General page, click the Start button to start Tomcat.

Using the Windows run command:2.
Select Start > Run.
In the Run box, type cmd, then click OK.
At the new command prompt, start Tomcat by typing
net start tomcat7
then press Enter.

b. Verify the OpenClinica Application

Open a web browser and access the OpenClinica at the following URL:
http://localhost:8080/OpenClinica
The OpenClinica login page should display.
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10.8 Install OpenClinica 3.2 on Linux
These instructions have been verified for CentOS 6.5.

These instructions are for installing version 3.2 of OpenClinica, and also apply to installing the
maintenance releases of 3.2 for example 3.2.1. When you see v.x or v.x.y in the instructions, use your
version number, e.g. 3.2.1.

 

Overview of Installation on Linux Systems
Use the following process to acquire, install, and configure OpenClinca and its software
dependencies. In each step, click the link to view detailed instructions for that step:



Ensure your operating system meets the specified requirements1.
Download the installation files2.
Install Java3.
Install Tomcat4.
Install PostgreSQL database5.
Set up the PostgreSQL database6.
Deploy OpenClinica within Tomcat7.
Set Tomcat to start8.
Configure the OpenClinica application9.
Restart the system and verify access to OpenClinica10.
Configure Tomcat to use HTTPS11.
Verify the installation by ensuring you can log in to OpenClinica.12.

After completing the OpenClinica installation, see the Overview of OpenClinica for instructions to
start using the application. A good first step is to define one or more users (especially a Study
Director) and then build a Study.

 

Operating System Requirements
The following packages should be installed for your Operating System:

vim
unzip
tar

You require "root" user access. Run all commands in the installation instructions using root-level
permission.

 

Download Installation Files
OpenClinica and OpenClinica Web Services run and depend on several external software
technologies: the Java Development Kit, the Apache Tomcat Servlet Container, and the PostgreSQL
relational database (unless you are using the Oracle database).

The OpenClinica website has a copy of the neccessary installers for Java, Tomcat, and PostgreSQL
for you to download. If you choose to use versions of Java, Tomcat, and PostgreSQL other than those
provided on the website, please note that they have not been tested with the OpenClinica
application. 

There are 32-bit and 64-bit editions of the software, when applicable. To determine if your system is
running a 32-bit or 64-bit operating system, in your Linux terminal, run

uname -a

The display reports the version:

If i386 or i686 displays, it is a 32-bit operating system.
If x86_64 displays, it is a 64-bit operating system.

https://docs.openclinica.com/3.1/openclinica-user-guide/overview-openclinica


To download the installation files:

Run the following commands to create the OpenClinica directory on your system and to make1.
it the current directory:

mkdir -p /usr/local/oc/install
cd /usr/local/oc/install
Run the following commands to download the Java, Tomcat, and PostgreSQL files for your2.
architecture. In the commands, substitute v.x with the version of OpenClinica you are
installing ( e.g. 3.1):

For 32-bit operating systems, to get the files from OpenClinica run:

Apache Tomcat:  https://openclinica.app.box.com/oc-downloads/1/2186656927

JDK and Postgres:
https://openclinica.app.box.com/oc-downloads/1/2186650849

For 64-bit operating systems, to get the files from OpenClinca, run:

Apache Tomcat: https://openclinica.app.box.com/oc-downloads/1/2186656927
JDK and Postgres:
https://openclinica.app.box.com/oc-downloads/1/2186651363

Instead of downloading the files from the above links, you can download them directly
from their native websites:

PostgreSQL:http://www.postgresql.org/

Java:http://www.oracle.com/technetwork/java/index.html

Tomcat:http://tomcat.apache.org/

Download the OpenClinica software from the OpenClinica website, using this3.
location:https://community.openclinica.com/project/openclinica. To download the software, you
need an OpenClinica community user account, which is free to create; you will be required to
log in to the account to download the OpenClinica software.

After downloading the OpenClinica software, move it to the directory where you downloaded
the other software components to:

/usr/local/oc/install

 

Install Java
The OpenClinica software is written in the Java programming language, so you must have Java
installed on your system in order to run the OpenClinica application.

https://openclinica.app.box.com/oc-downloads/1/2186650849
https://openclinica.app.box.com/oc-downloads/1/2186650849
https://openclinica.app.box.com/oc-downloads/1/2186650849
https://openclinica.app.box.com/oc-downloads/1/2186651363
http://www.postgresql.org/
http://www.oracle.com/technetwork/java/index.html
http://tomcat.apache.org/
https://community.openclinica.com/project/openclinica
https://community.openclinica.com/user/register


The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

cd /usr/local/oc/install

Install Java by running:2.

tar -zxvf jdk-7*

Install Java in the operating system by running:3.

mv jdk1* /usr/local/
ln -s /usr/local/jdk1* /usr/local/java

Java is now installed in the correct location.

 

Install Tomcat
The OpenClinica software uses the Apache Tomcat Java application server.

The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

cd /usr/local/oc/install

Install Tomcat by running the following:2.

tar -zxvf apache-tomcat-*
mv apache-tomcat-* /usr/local/
ln -s /usr/local/apache-tomcat-7.0.52 /usr/local/tomcat
/usr/sbin/adduser tomcat

Move the web apps provided with Tomcat that are not needed by OpenClinica to another3.
location by running:

mkdir /usr/local/tomcat/oldwebapps
mv /usr/local/tomcat/webapps/* /usr/local/tomcat/oldwebapps

Tomcat is now installed.

 

Install PostgreSQL Database
The OpenClinica software uses PostgreSQL as an underlying relational database management
system. Complete these instructions to install the PostgreSQL database.

The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.

http://tomcat.apache.org/


current directory by running:

cd /usr/local/oc/install

Start the PostgreSQL setup by running:2.

chmod a+x postgresql-8.4.*
./postgresql-8.4.* --mode text

The PostgreSQL Setup Wizard starts.

For most of the options in the Setup Wizard, accept the defaults. Complete the Setup Wizard3.
as follows:

Prompt Action
Installation Directory [/opt/PostgreSQL/8.4] Press Enter to accept.
Data Directory [/opt/PostgreSQL/8.4/data] Press Enter to accept.

Password
Enter a password for the PostgreSQL
database superuser, then press Enter.
Record the password because you will
need it again in this installation.

Retype Password Type the password again, then
pressEnter.

Port [5432] Press Enter to accept.
Please choose an option [1] Press Enter to accept.
Install pl/pgsql in template1 database? [Y/n] Type n, then press Enter.
Do you want to continue? [Y/n] Press Enter to accept.
Setup has finished installing PostgreSQL on your
computer.

Stack Builder may be used to download and install
additional tools, drivers and applications to
complement your PostgreSQL installation. [Y/n]

Type n, then press Enter.

        

PostgreSQL is now installed on your system and will start when you start up your system.

 

Set Up the PostgreSQL Database
Complete these instructions to set up the PostgreSQL database. 

Run the following commands to create the PostgreSQL database and database user1.
OpenClinica uses to connect to the database:

/opt/PostgreSQL/8.4/bin/psql -U postgres -c "CREATE ROLE clinica LOGIN ENCRYPTED
PASSWORD 'clinica' SUPERUSER NOINHERIT NOCREATEDB NOCREATEROLE"



/opt/PostgreSQL/8.4/bin/psql -U postgres -c "CREATE DATABASE openclinica WITH
ENCODING='UTF8' OWNER=clinica"

The database user password is set to clinica by default, which is not a secure password.2.
Change the password as follows:

Run:1.

/opt/PostgreSQL/8.4/bin/psql -U postgres

A psql prompt displays with this message:2.

ALTER USER clinica WITH PASSWORD 'XXXX';

Replace XXXX with a secure password. Record the password for use in a later3.
installation step.

Exit the psql prompt by running:4.

q

 

Deploying OpenClinica within Tomcat
The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

cd /usr/local/oc/install

Run the following commands. In the commands, v.x is your version of OpenClinica, e.g. 3.2:2.

unzip OpenClinica-v.x*
cd OpenClinica-v.x*/distribution
unzip OpenClinica.war -d OpenClinica
cp -rf OpenClinica* /usr/local/tomcat/webapps

OpenClinica is now deployed for use with the database.

 

Deploying OpenClinica Web Services within Tomcat
Web Services are optional. Do not install them if you are not planning to use them.

The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

cd /usr/local/oc/install

Run the following commands. In the commands, v.x is your version of OpenClinica, e.g. 3.2:2.



unzip OpenClinica-ws-v.x*
cd OpenClinica-ws-v.x*/distribution
unzip OpenClinica-ws.war -d OpenClinica-ws
cp -rf OpenClinica* /usr/local/tomcat/webapps

OpenClinica web services are now deployed for use with the database.

 

Set Tomcat to Start
You can set Tomcat to automatically start when you start your system, or you can start and stop
Tomcat manually by issuing commands.

To set Tomcat to start automatically on system startup, run the following:

cp /usr/local/oc/install/OpenClinica-v.x*/install-docs/linux/tomcat /etc/init.d/

cd /etc/init.d

chmod a+x /etc/init.d/tomcat

/sbin/chkconfig --add tomcat (Note: This command is only for Red Hat Linux. For other operating
systems, see the operating system instructions for adding an init script.)

To stop and start Tomcat manually by issuing commands, run the following:

/usr/local/tomcat/bin/shutdown.sh (stops Tomcat)

/usr/local/tomcat/bin/startup.sh (starts Tomcat)

 

Configure OpenClinica for Optimum Performance
Under stress tests, OpenClinica 3.1.3 has performed well with the following JVM (Java Virtual
Machine) settings: 

Edit the init.d/tomcat and replace the JAVA_OPTS with following:

export JAVA_OPTS="$JAVA_OPTS   -Xmx1280m -XX:+UseParallelGC -XX:ParallelGCThreads=n -
XX:MaxPermSize=180m -XX:+CMSClassUnloadingEnabled"

For the setting -XX:ParallelGCThreads=n, n should be replaced with the # of cores of your CPU as
long as the total number of cores are lesser than 8.

The number of cores can be determined by using 'top' command.

Please note that the minimum RAM requirement is 1280 MB of memory for these settings, so the
server is expected to have much higher RAM available. The amount of available memory can be
determined by using the command free -m to give the memory (in MB). The MaxPermSize value



depends on the number of war files that you are deploying. The web war needs a 180m of PermGen
and the ws war needs a 90m of PermGen memory settings.

For the settings to take effect, restart the Tomcat server.

 

Configure the OpenClinica Application
If you followed all the previous instructions exactly, there is only one property in the configuration
file, datainfo.properties, that you may need to change in order for OpenClinica to start. There are
other properties in the configuration file you will probably want to modify for your system.

Open the configuration file: /usr/local/tomcat/webapps/OpenClinica/WEB-1.
INF/classes/datainfo.properties
Edit values for the properties in the datainfo.properties file. You must change the value2.
for dbPass to the password you selected in Set Up the PostgreSQL Database. Change the
values for any other properties, then save the file.
Update the filePath parameter to the right value.3.
Run the following commands:4.

chown -R tomcat /usr/local/tomcat/*
chown -R tomcat /usr/local/apache-*
You may also need to configure OpenClinica for internationalization should you wish to utilize5.
OpenClinica in different languages. Also, if you need to use some UTF-8 characters in your
application, you may need to modify your default connecter configuration. For more
information regarding configuring OpenClinica for internationalization and using UTF-8
characters, please refer to
 https://docs.openclinica.com/3.1/technical-documents/openclinica-and-internationalization

 

Configure the OpenClinica Web Services
If you followed all the previous instructions exactly, there is only one property in the configuration
file, datainfo.properties, that you may need to change in order for OpenClinica Web Services to
start. There are other properties in the configuration file you will probably want to modify for your
system.

Note: Most of the properties are not needed or used for Web Services, see Description of
datainfo.properties File for Web Services for more information on what settings are actually used.

Open the configuration file: /usr/local/tomcat/webapps/OpenClinica-ws/WEB-1.
INF/classes/datainfo.properties
Edit values for the properties in the datainfo.properties file. You must change all values from2.
Database Configuration section of datainfo.properties file to reflect your settings in
datainfo.properties file for OpenClinica application. Change the values for any other
properties. 
Run the following commands:3.

chown -R tomcat /usr/local/tomcat/*

https://docs.openclinica.com/3-1/installation/install-3-2-linux/
https://docs.openclinica.com/3.1/technical-documents/openclinica-and-internationalization
https://docs.openclinica.com/3-1/installation/3-1-installation-install-3-1-x-linux/#content-8452


chown -R tomcat /usr/local/apache-*

 

Description of datainfo.properties File
The datainfo.properties file will look similar to the following. Each group of properties is numbered
and a description of the property group is presented as a series of comment lines (lines that begin
with # are comments) before the section where you specify the values for the properties in the
group.

#############################################################
################

# 1 - Database Configuration

#

# Database configuration is done with the following 6 properties

# The dbType options are either postgres or oracle.

# Enter the user name and password to access the database in 

# dbUser and dbPass.

# The db field is for the name of the database and provide the port

# in dbPort.

# dbHost can be a URL, IP address or localhost

#

# REQUIRED

#############################################################
################

dbType=postgres

dbUser=clinica

dbPass=clinica

db=${WEBAPP.lower}

dbPort=5432

dbHost=localhost

#############################################################



################

# 2 - filePath

#

# File Path is the string which declares the

# repository for all uploaded and generated

# files in the system, including CRFs and

# data sets.  The directory should NOT be

# accessible by the web server.

#

# REQUIRED.  

#############################################################
################

filePath=${catalina.home}/${WEBAPP.lower}.data/

#############################################################
################

# 3 - Attached File Location

# Location for files if item data type is "file". If it has been kept empty,

# "filePath" will be used as the attached file location.

# This will be a sub folder within the filePath location only.

# You may configure a full path that points to a directory outside of the filePath.

# If you configure a full path, it must have a trailing slash.

# Example = /usr/local/attached_file/ or C:\attached_file\

#

# NOT REQUIRED

#############################################################
################

# attached_file_location=



#############################################################
################

# 4 - user_account_notification

#

# User Account Notification is the method by

# which new users are sent their passwords.

# Users can be sent passwords via email,

# or the password can be displayed on the screen

# to the administrator, who is instructed to

# write it down and physically give it to the user

# in question.  The default is email.

#

# REQUIRED.  

#############################################################
################

userAccountNotification=email

#############################################################
################

# 5 - adminEmail

#

# The Admin Email is the field to set the administrator's

# email for a given server. It is also used for

# replies to the email messages sent by the system.

#

# REQUIRED

#############################################################
################

adminEmail=admin@example.com



#############################################################
################

# 6- Spring Based Email System

#

# Configure the Email SMTP host below. If the host

# requires a username and password make sure

# mail.smtp(s).auth is set to true.

# Configure mail protocol via mail.protocol, Valid options 

# would be smtp or smtps.

# Configure smtp over ttls by setting mail.smtp(s).starttls.enable

# to true.

# Configure connection timeout. Preconfigred to 5 secs

#############################################################
################

mailHost=mail.smtp.com

mailPort=25

mailProtocol=smtp

mailUsername=

mailPassword=

mailSmtpAuth=false

mailSmtpStarttls.enable=false

mailSmtpsAuth=false

mailSmtpsStarttls.enable=false

mailSmtpConnectionTimeout=100

mailErrorMsg=developers@openclinica.org

#############################################################
################

# 8 - sysURL



#

# The web address for the system.  It can either be an external

# address (demo.openclinica.org) or an internal IP

# address (192.168.2.000).

# NOTE: If you reconfigure the address or port in some later

# step, such as by configuring SSL, you will need to come back

# and update this file. You will also need to restart tomcat

# for changes to this take effect.

#

# REQUIRED

#############################################################
################

sysURL=http://localhost:8080/${WEBAPP}/MainMenu

#############################################################
################

# 9 - max_inactive_interval

#

# This is maximum time interval between client requests. That is,

# if users leave any page open without sending a request to the 

# server, after this time interval, when users attempt sending 

# request they will be directed to login page.

#

# REQUIRED

#############################################################
################

maxInactiveInterval=3600

#############################################################
################



# 11 - Logging configuration

# SysLog support has been fully implemented in OpenClinica, but by default has been turned off.

# Every piece of code that could send information to the syslog server has not been reviewed 

# and cleaned to ensure it is entirely readable and useful.  This will be an ongoing effort 

# and resolved in a future release.  Please use the SysLog support at your own risk.

#

# Specify the log location - local/syslog/both

#

log.dir=${catalina.home}/logs/openclinica

logLocation=local

#

# Specify logging level - trace/debug/info/warn/error

logLevel=info

syslog.host=localhost

syslog.port=514

#############################################################
################

# 12- News/About

# On the OpenClinica login screen, there will be a box to the right of the login section

# which can contain an RSS feed.  You can configure what RSS feed is used in the rss.rl field.

# If you do not want the RSS feed, please comment out rss.url and rss.more and uncomment

# about.text1 and about.text2.  These two fields can be used for any free form text that you

# you want to appear on the OpenClinica login page.

# the default feed is http://clinicalresearch.wordpress.com/feed/

# default value for rss.more http://clinicalresearch.wordpress.com/

#############################################################
################



# rssUrl=http://clinicalresearch.wordpress.com/feed/

# rssMore=http://clinicalresearch.wordpress.com/

# about.text1= Hello World 1

# about.text2= Hello World 2

#############################################################
################

# 13 - CRF File Upload Configuration

# crf.file.extensionSettings can have 3 values valid,invalid or left empty which defaults to valid.

# if crf.file.extensionSetting= valid , then extensions specified can be uploaded.

# if crf.file.extensionSetting= invalid , then extensions specified can NOT be uploaded.

# if crf.file.extensions is left empty and crf.file.extensionSettings=valid then all extensions are valid

# if crf.file.extensions is left empty and crf.file.extensionSettings=invalid then all extensions are
NOT valid  

# separate extensions with a comma and do not include the leading dot.

#############################################################
################

# crfFileExtensions=

# crfFileExtensionSettings=

#############################################################
################

# 14 - supportURL

#

# The Support URL is included in the support button that appears

# in the top right corner of all pages in OPenClinica. By including

# the URL here we will be able to configure it depending on the adopter

# 

# REQUIRED 

#############################################################



################

# supportURL=https://www.openclinica.com/OpenClinica/3.1/support/ 

#############################################################
################

# 15- Quartz Scheduler Configuration

#

# Configure the mis-fire threshold for the scheduler, 

# and the number of extract jobs can run at a single time.

#

# REQUIRED

#############################################################
################

org.quartz.jobStore.misfireThreshold=18000000

org.quartz.threadPool.threadCount=1

org.quartz.threadPool.threadPriority=5

#############################################################
################

# 16 - CCTS configuration

# 

# This is used for OpenClinica instances that have been modified and configured

# to work with the Cancer Clinical Trials Suites.  This is a caBIG suite of applications.

# The configuration determines how long OpenClinica will hold a transaction from C3PR

# and will wait for a roll back message before committing it to the database.

#

# NOT REQUIRED

#############################################################
################

ccts.waitBeforeCommit=6000



#############################################################
################

# 17 - Facility information

#

# The OpenClinica defaults will be used when creating a new study

# unless you uncomment each property and provide a value next to 

# each = sign.

#

# NOT REQUIRED

#############################################################
################

# FacName=

# FacCity=

# FacState=

# FacZIP=

# FacCountry=

# FacContactName=

# FacContactDegree=

# FacContactPhone=

# FacContactEmail=

#############################################################
################

# 18 - export data file path

#

# Export Data File Path is the string which (optionally) 

# declares a specific file path for file extracts to be

# saved.  This is a sub folder of filePath.

# Note that if it is set, files from Jobs only will be saved 



# to two places: this directory and under the above file path

# declared in the 'filePath' property.

#

# NOT REQUIRED.  Please comment out if you want Jobs to generate

# one file/files only, in the directory structure under 'filePath'.

#############################################################
################

# exportFilePath=scheduled_data_export

#############################################################
#

# extract.number defines how many subjects the system will paginate through when creating the
ODM file to

# to be transformed by the XSLT engine.  This number can be increased to use higher amounts of
memory and

# potentially decrease the amount of wait time.  Lower this number if you have an extremely large
amount of

# event definitions to reduce the impact on concurrent users in the system at the time of the extract.

# This is a global setting that applies to all extracts in your OpenClinica instance.

#############################################################
########################

extract.number=99

#############################################################
################

# 19 - Usage statistics configuration

# Usage statistics refers to information automatically sent back to OpenClinica.org

# to help us figure out how well OpenClinica is working and help us improve it in 

# future versions.

# This includes technical information such as the version of OpenClinica installed, the number of
studies created and user load. These statistics DO NOT include information such as study or CRF
names, study data, or user information. We collect this data in aggregate and use it according to our



Privacy Policy [https://community.openclinica.com/privacy-policy] to improve our products and
services.

#

# As part of system configuration, we give you the option to help us improve OpenClinica by sending
these usage statistics. If you elect to send this information but later change your mind, you can
disable this feature in the datainfo.properties file by changing 

# 'collectStats' value to 'false'

collectStats=true

usage.stats.host=usage.openclinica.com

usage.stats.port=514

OpenClinica.version=3.2

#############################################################
################

# 20 - Rule Designer configuration

# OpenClinica Enterprise customers are allowed access to a GUI based Rule Designer.  

# This configuration allows the OpenClinica instance to contact the Rule Designer for 

# access.  If you are not an OpenClinica Enterprise customer, your users will be re-directed

# to a landing page and will have to navigate back to their OpenClinica instance.

# If you do not want to see a link to the Rule Designer on the Build Study page, 

# you must delete this configuration option.

# 

# To become an OpenClinica Enterprise customer, please contact sales@openclinica.com

#############################################################
################

designerURL=http://localhost:8080/designer/

#############################################################
################

# 21 - LDAP/Active Directory configuration

#

# IMPORTANT: To use LDAP, the property of the configuration number '10 -
change_passwd_required' must be set to '0'



# 

#############################################################
################

# If ldap is enabled (values:'true' or 'false')

ldap.enabled=false

# LDAP host in the form 'ldap://<host>:<port">'

ldap.host=

# User distinguished name used to authenticate to LDAP

#ldap.userDn=cn=ldap1,ou=ldap,dc=dc1,dc=dc2

ldap.userDn=cn=chin,ou=chin_ldap,dc=dc1,dc=dc2

# Password used to authenticate to LDAP

ldap.password=

# Query used to during login to find the LDAP user by username. Should always return a maximum
of one result.

ldap.loginQuery=(sAMAccountName={0})

# URL to redirect LDAP users to retrieve a forgotten password

ldap.passwordRecoveryURL=http://www.google.com?&q=what+do+i+do+if+i+forgot+my+passwo
rd%3F

# BaseDN to search for users

ldap.userSearch.baseDn=DC=dc1,dc=dc2

# Query used to search users in the user search screen (when creating a new user). 



# The '{0}' placehoder is replaced by the value typed in the 'filter' field.

# Simple query, searches only username

#ldap.userSearch.query=(&(memberOf=CN=ldapgroup,OU=ldap,DC=dc1,DC=dc2)(sAMAccountN
ame=*{0}*))

#

# Sophisticated query, searches username, first name, last name and email

ldap.userSearch.query=(&(memberOf=CN=ldapgroup,OU=ldap,DC=dc1,dc=dc2)(|(sAMAccountNa
me=*{0}*)))

# Field used to retrieve the user's distinguished name

ldap.userData.distinguishedName=distinguishedName

# Field used to retrieve the user's username

ldap.userData.username=sAMAccountName

# Field used to retrieve the user's first name 

ldap.userData.firstName=givenName

# Field used to retrieve the user's last name

ldap.userData.lastName=sn

# Field used to retrieve the user's email

ldap.userData.email=mail

# Field used to retrieve the user's organization

ldap.userData.organization=company 

 



Description of datainfo.properties File for Web Services
Web Services datainfo.properties file is similar the datainfo.properties of OpencClinica. However,
web services needs less configuration than OpenClinica. The following file show highlighted
properties that are relevant to web services. Only properties from first section must be updated and
should be set exaclty as they are set for OpenClinica.

 

#############################################################
################

# 1 - Database Configuration

#

# Dateabase configuration is done with th following 6 properties

# The dbType options are either postgres or oracle.

# Enter the user name and password to access the database in 

# dbUser and dbPass.

# The db field is for the name of the database and provide the port

# in dbPort.

# dbHost can be a URL, IP address or localhost

#

# REQUIRED

#############################################################
################

dbType=postgres

dbUser=clinica

dbPass=clinica

db=openclinica

dbPort=5432

dbHost=localhost

 

#############################################################
################



# 2 - filePath

#

# File Path is the string which declares the

# repository for all uploaded and generated

# files in the system, including CRFs and

# data sets.  The directory should NOT be

# accessible by the web server.

#

# REQUIRED.  

#############################################################
################

filePath=${catalina.home}/${WEBAPP.lower}.data/

 

#############################################################
################

# 3 - Attached File Location

# Location for files if item data type is "file". If it has been kept empty,

# "filePath" will be used as the attached file location.

# This will be a sub folder within the filePath location only.

# You may configure a full path that points to a directory outside of the filePath.

# If you configure a full path, it must have a trailing slash.

# Example = /usr/local/attached_file/ or C:\attached_file\

#

# NOT REQUIRED

#############################################################
################

# attached_file_location=

 

#############################################################
################



# 4 - user_account_notification

#

# User Account Notification is the method by

# which new users are sent their passwords.

# Users can be sent passwords via email,

# or the password can be displayed on the screen

# to the administrator, who is instructed to

# write it down and physically give it to the user

# in question.  The default is email.

#

# REQUIRED.  

#############################################################
################

userAccountNotification=email

 

#############################################################
################

# 5 - adminEmail

#

# The Admin Email is the field to set the administrator's

# email for a given server. It is also used for

# replies to the email messages sent by the system.

#

# REQUIRED

#############################################################
################

adminEmail=admin@example.com

 

#############################################################
################



# 6- Spring Based Email System

#

# Configure the Email SMTP host below. If the host

# requires a username and password make sure

# mail.smtp(s).auth is set to true.

# Configure mail protocol via mail.protocol, Valid options 

# would be smtp or smtps.

# Configure smtp over ttls by setting mail.smtp(s).starttls.enable

# to true.

# Configure connection timeout. Preconfigred to 5 secs

#############################################################
################

mailHost=mail.smtp.com

mailPort=25

mailProtocol=smtp

mailUsername=

mailPassword=

mailSmtpAuth=false

mailSmtpStarttls.enable=false

mailSmtpsAuth=false

mailSmtpsStarttls.enable=false

mailSmtpConnectionTimeout=100

mailErrorMsg=developers@openclinica.org

 

 

 

#############################################################
################

# 8 - sysURL



#

# The web address for the system.  It can either be an external

# address (demo.openclinica.org) or an internal IP

# address (192.168.2.000).

# NOTE: If you reconfigure the address or port in some later

# step, such as by configuring SSL, you will need to come back

# and update this file. You will also need to restart tomcat

# for changes to this take effect.

#

# REQUIRED

#############################################################
################

sysURL=http://localhost:8080/${WEBAPP}/MainMenu

 

#############################################################
################

# 9 - max_inactive_interval

#

# This is maximum time interval between client requests. That is,

# if users leave any page open without sending a request to the 

# server, after this time interval, when users attempt sending 

# request they will be directed to login page.

#

# REQUIRED

#############################################################
################

maxInactiveInterval=3600

 

#############################################################
###############



# 11 - Logging configuration

# SysLog support has been fully implemented in OpenClinica, but by default has been
turned off.

# Every piece of code that could send information to the syslog server has not been
reviewed 

# and cleaned to ensure it is entirely readable and useful.  This will be an ongoing effort 

# and resolved in a future release.  Please use the SysLog support at your own risk.

#

# Specify the log location - local/syslog/both

#

log.dir=${catalina.home}/logs/openclinica-ws

logLocation=local

#

# Specify logging level - trace/debug/info/warn/error

logLevel=info

syslog.host=localhost

syslog.port=514

 

#############################################################
################

# 12- News/About

# On the OpenClinica login screen, there will be a box to the right of the login section

# which can contain an RSS feed.  You can configure what RSS feed is used in the rss.rl field.

# If you do not want the RSS feed, please comment out rss.url and rss.more and uncomment

# about.text1 and about.text2.  These two fields can be used for any free form text that you

# you want to appear on the OpenClinica login page.

# the default feed is http://clinicalresearch.wordpress.com/feed/

# default value for rss.more http://clinicalresearch.wordpress.com/

#############################################################
################



# rssUrl=http://clinicalresearch.wordpress.com/feed/

# rssMore=http://clinicalresearch.wordpress.com/

# about.text1= Hello World 1

# about.text2= Hello World 2

 

#############################################################
################

# 13 - CRF File Upload Configuration

# crf.file.extensionSettings can have 3 values valid,invalid or left empty which defaults to valid.

# if crf.file.extensionSetting= valid , then extensions specified can be uploaded.

# if crf.file.extensionSetting= invalid , then extensions specified can NOT be uploaded.

# if crf.file.extensions is left empty and crf.file.extensionSettings=valid then all extensions are valid

# if crf.file.extensions is left empty and crf.file.extensionSettings=invalid then all extensions are
NOT valid  

# separate extensions with a comma and do not include the leading dot.

#############################################################
################

# crfFileExtensions=

# crfFileExtensionSettings=

 

#############################################################
################

# 14 - supportURL

#

# The Support URL is included in the support button that appears

# in the top right corner of all pages in OPenClinica. By including

# the URL here we will be able to configure it depending on the adopter

# 

# REQUIRED 

#############################################################



################

# supportURL=https://www.openclinica.com/OpenClinica/3.1/support/ 

 

#############################################################
################

# 15- Quartz Scheduler Configuration

#

# Configure the mis-fire threshold for the scheduler, 

# and the number of extract jobs can run at a single time.

#

# REQUIRED

#############################################################
################

org.quartz.jobStore.misfireThreshold=18000000

# threadCount should be set to zero on web services modules

org.quartz.threadPool.threadCount=0

org.quartz.threadPool.threadPriority=5

 

#############################################################
################

# 16 - CCTS configuration

# 

# This is used for OpenClinica instances that have been modified and configured

# to work with the Cancer Clinical Trials Suites.  This is a caBIG suite of applications.

# The configuration determines how long OpenClinica will hold a transaction from C3PR

# and will wait for a roll back message before committing it to the database.

#

# NOT REQUIRED

#############################################################
################



ccts.waitBeforeCommit=6000

 

#############################################################
################

# 17 - Facility information

#

# The OpenClinica defaults will be used when creating a new study

# unless you uncomment each property and provide a value next to 

# each = sign.

#

# NOT REQUIRED

#############################################################
################

# FacName=

# FacCity=

# FacState=

# FacZIP=

# FacCountry=

# FacContactName=

# FacContactDegree=

# FacContactPhone=

# FacContactEmail=

 

#############################################################
################

# 18 - export data file path

#

# Export Data File Path is the string which (optionally) 

# declares a specific file path for file extracts to be



# saved.  This is a sub folder of filePath.

# Note that if it is set, files from Jobs only will be saved 

# to two places: this directory and under the above file path

# declared in the 'filePath' property.

#

# NOT REQUIRED.  Please comment out if you want Jobs to generate

# one file/files only, in the directory structure under 'filePath'.

#############################################################
################

# exportFilePath=scheduled_data_export

#############################################################
################

# 19 - Usage statistics configuration

# Usage statistics refers to information automatically sent back to OpenClinica.org

# to help us figure out how well OpenClinica is working and help us improve it in 

# future versions.

# This includes technical information such as the version of OpenClinica installed, the number of
studies created and user load. These statistics DO NOT include information such as study or CRF
names, study data, or user information. We collect this data in aggregate and use it according to our
Privacy Policy [https://community.openclinica.com/privacy-policy] to improve our products and
services.

#

# As part of system configuration, we give you the option to help us improve OpenClinica by sending
these usage statistics. If you elect to send this information but later change your mind, you can
disable this feature in the datainfo.properties file by changing 

# 'collectStats' value to 'false'

collectStats=true

usage.stats.host=usage.openclinica.com

usage.stats.port=514

OpenClinica.version=3.2

 

#############################################################



################

# 20 - Rule Designer configuration

# OpenClinica Enterprise customers are allowed access to a GUI based Rule Designer.  

# This configuration allows the OpenClinica instance to contact the Rule Designer for 

# access.  If you are not an OpenClinica Enterprise customer, your users will be re-directed

# to a landing page and will have to navigate back to their OpenClinica instance.

# If you do not want to see a link to the Rule Designer on the Build Study page, 

# you must delete this configuration option.

# 

# To become an OpenClinica Enterprise customer, please contact sales@openclinica.com

#############################################################
################

designerURL=https://designer.openclinica.com/

 

 

 

#############################################################
################

# 21 - LDAP/Active Directory configuration

#

# IMPORTANT: To use LDAP, the property of the configuration number '10 -
change_passwd_required' must be set to '0'

# 

#############################################################
################

 

# If ldap is enabled (values:'true' or 'false')

ldap.enabled=false

 

# LDAP host in the form 'ldap://<host>:<port">'



ldap.host=

 

# User distinguished name used to authenticate to LDAP

#ldap.userDn=cn=ldap1,ou=ldap,dc=dc1,dc=dc2

ldap.userDn=cn=chin,ou=chin_ldap,dc=dc1,dc=dc2

 

# Password used to authenticate to LDAP

ldap.password=

 

# Query used to during login to find the LDAP user by username. Should always return a
maximum of one result.

ldap.loginQuery=(sAMAccountName={0})

 

# URL to redirect LDAP users to retrieve a forgotten password

ldap.passwordRecoveryURL=http://www.google.com?&q=what+do+i+do+if+i+forgot+my+
password%3F

 

# BaseDN to search for users

ldap.userSearch.baseDn=DC=dc1,dc=dc2

 

# Query used to search users in the user search screen (when creating a new user). 

# The '{0}' placehoder is replaced by the value typed in the 'filter' field.

 

# Simple query, searches only username

#ldap.userSearch.query=(&(memberOf=CN=ldapgroup,OU=ldap,DC=dc1,DC=dc2)(sAMAc
countName=*{0}*))

#

 

# Sophisticated query, searches username, first name, last name and email



ldap.userSearch.query=(&(memberOf=CN=ldapgroup,OU=ldap,DC=dc1,dc=dc2)(|(sAMAcc
ountName=*{0}*)))

 

# Field used to retrieve the user's distinguished name

ldap.userData.distinguishedName=distinguishedName

 

# Field used to retrieve the user's username

ldap.userData.username=sAMAccountName

 

# Field used to retrieve the user's first name 

ldap.userData.firstName=givenName

 

# Field used to retrieve the user's last name

ldap.userData.lastName=sn

 

# Field used to retrieve the user's email

ldap.userData.email=mail

 

# Field used to retrieve the user's organization

ldap.userData.organization=company

 

Verify Access to OpenClinica

At this point, Java, Tomcat, PostgreSQL, and OpenClinica are installed and set up. Restart the
system by running:

reboot

After the system starts up, access OpenClinica at the following URL:

http://localhost:8080/OpenClinica

The Log In page should display.



To verify your set-up, try to access OpenClinica from another computer by running the same
command from that computer, but replace localhost with the server's IP or hostname.

 

Verify Access to OpenClinica Web Services
At this point, Java, Tomcat, PostgreSQL, and OpenClinica and OpenClinica Web Services are
installed and set up. Restart the system by running:

reboot

After the system starts up, access OpenClinica Web Services at the following URL:

http://localhost:8080/OpenClinica-ws

The Welcome page should display.

To verify your set-up, try to access OpenClinica Web Services from another computer by running the
same command from that computer, but replace localhost with the server's IP or hostname.

 

Configure Tomcat to Use HTTPS
OpenClinica strongly recommends securing the Tomcat application server using a Secure Socket
Layer protocol (SSL). SSL is a data transport encryption technology used to make
secure https:// connections. SSL requires a third-party security certificate to be effective.
Information about configuring SSL certificates for Tomcat is at this
website: http://tomcat.apache.org/tomcat-6.0-doc/ssl-howto.html.

 

Verify the Installation
Log in to OpenClinica with the username root and the password 12345678. OpenClinica requires you
to change the password for the user "root" to a secure password. See Update User Profile if you
need more information.

The user "root" is assigned to the Study "Default". Create a user account login for yourself, with the
User Type set to "technical administrator" and the User Role set to Data Manager. For instructions
to create the user account, see Create a New User.

Functional approval by Rahul Sundaram. Signed on 2014-07-10 12:24PM

Approved for publication by Ben Baumann. Signed on 2014-07-10 12:29PM

Not valid unless obtained from the OpenClinica document management system on the day of
use.

http://tomcat.apache.org/tomcat-6.0-doc/ssl-howto.html
https://docs.openclinica.com/3.1/openclinica-user-guide/working-openclinica#content-title-3603
https://docs.openclinica.com/3.1/administer-users#content-title-2979


10.9 Install OpenClinica 3.2 on Windows
These installation instructions have been verified on the following Windows operating systems
versions:

Windows Server 2003 Standard Edition SP2
Windows Server 2003 Standard Edition SP1

Please note that all these instructions require Administrator-level permissions.

These instructions are for installing version 3.2 of OpenClinica. Screenshots shown in these
instructions might look different than the screens on your system because your operating system
might not be exactly the same. For the same reason, your screenshots might not correspond exactly
with those in the written instructions. Where the screenshot differs from the written instruction,
always follow the written instruction.

All characters in the installation commands are case sensitive. Also note that any additional white
space between or after characters in commands could cause installation errors.

9.3.1 Overview of Installation on Windows Systems
Use the following process to acquire, install, and configure OpenClinca and its software
dependencies. In each step, click the link to view detailed instructions for that step:

9.3.2 Ensure your system complies with software dependencies and operating system
requirements.
9.3.3 Install Java
9.3.4 Install PostgreSQL
9.3.5 Install Tomcat
9.3.6 Starting and Stopping Tomcat
9.3.7 Set Up the PostgreSQL Database
9.3.8 Configure Tomcat to Work with OpenClinica and OpenClinica Web Services
9.3.9 Configure the OpenClinica Installation
9.3.10 Verify the Installation
9.3.11 Install OpenClinica Web Services Package
9.3.12 Configure OpenClinica Web Services
9.3.13 Verify the Installation of OpenClinica Web Services

After completing the OpenClinica installation, see the Overview of OpenClinica for instructions to
start using the application. A good first step is to define one or more users (especially a Study
Director), and then build a Study.

9.3.2 Software Dependencies and Operating System Requirements

Windows Configuration
Your Windows operating system must be configured to show file extensions by default. To configure
this behavior:
1. Open a Windows Explorer window.
2. Select Tools > Folder Options.
3. Click the View tab.
4. In Advanced settings, clear the Hide extensions for known file types checkbox.
5. Click Apply.



Software Dependencies
OpenClinica runs on any Servlet/JSP container that implements the Servlet 2.4 and JavaServer Pages
2.0 specifications from the Java Community Process. OpenClinica was developed to run on and has
been tested with Apache Tomcat 7.0.52.

OpenClinica runs on the PostgreSQL relational database. Using a
JDBC (Java Database Connectivity) driver, the database connects to the OpenClinica web application
and provides the data to the user.

New installations require the following software dependencies, all of which are open source. These
installation instructions walk through the process of downloading, installing, and configuring them
for use with OpenClinica.

Java 7 Standard Edition Development Kit 7.0 update 52 (Note: Java frequently changes its
naming conventions.)
Tomcat 7.0.52
PostgreSQL 8.4.7.2

Other Versions of Dependent Software
The software dependencies OpenClinica uses are frequently updated with minor versions and
revisions. Sometimes only a matter of weeks separates the release of two adjacent versions. In some
cases, the particular revision number used may no longer be available. In general, you should be
able to use more recent minor versions and revisions of the software dependencies. For example, if
the installation instructions refer to PostgreSQL 8.4.7.2, then PostgreSQL 8.4.8 should work
successfully too (but not PostgreSQL 9).
Record the version or revision number of all the software you use. If you have concerns about a
particular combination, post your question to the OpenClinica Forums.

9.3.3 Install Java

The OpenClinica software is written in the Java programming language, so you must have Java
installed on your system in order to run the OpenClinica application. Follow these instructions to
install Java:

OpenClinica 3.2 is designed to run on a Java 7 SDK platform. To avoid conflicts with other1.
versions of Java, clear out any other Java installations on the system. Select Start > Control
Panel > Add Remove Programs, then remove any Java JREs and SDKs.
Create the directory c:ocinstall.2.
From one of the following websites, download the Java 7 SE Development Kit 7.0 update 523.
(jdk-7u51-windows-i586.exe ) into c:ocinstall:

From the Java website:
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html

4. Run c:ocinstalljdk-7u51-windows-i586.exe.

5. The Open File - Security Warning message displays.

6. Click Run.
The Welcome to Java Installation Wizard opens.
7. Click Next.
The Custom Setup screen displays.
8. Click Change....

https://www.openclinica.com/forums
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html


9. Change the path to c:oc jdk1.7.0_51, then click OK.
The Custom Setup screen should now look like this:

10. Click Next.
The Setup Wizard installs the JDK. When setup completes, a screen to install JRE7 displays.
11. Click Cancel, and then in the confirmation dialog box click Yes.
The Install Success screen displays.
12. Click Close.
13. A web browser window opens, presenting you with the option to register the JDK. Register, or
close the window.

9.3.4 Install PostgreSQL Database

The OpenClinica software uses the PostgreSQL relational database management system.  Complete
these instructions to install PostgreSQL.

From this location1.
http://www.enterprisedb.com/postgresql-8421-installers-win32?ls=Crossover&type=Crossover
, download the executable to c:ocinstall.
Run the executable.2.
The Open File Security Warning message displays
Click Run.3.
The PostgreSQL Installation Wizard opens.
Click Next.4.
The Installation directory screen displays.
Click Next to accept the default values.5.
The Data directory screen displays.
Click Next to accept the default values.6.
The Password screen displays.
Enter a password for the Postgres superuser. Record the password for use later in the7.



installation process. Re-enter the password, and click Next.
The Port screen displays.
Click Next to accept the default value (5432).8.
The Advanced Options screen displays.

Complete the screen as follows:9.
1. For Locale, select Default locale.
2. Clear the Install pl/pgsql in template1 database? checkbox.
3. Click Next.
The Ready to install screen displays
Click Next to start the installation.10.
When the installation finishes, the Completing the PostgreSQL Setup Wizard screen
displays.
Clear the Launch Stackbuilder at exit checkbox, then click Finish.11.

9.3.5 Install Tomcat

From either of the following websites, download the Windows Service Installer Version,1.
apache-tomcat-7.0.52.exe, and save it to c:ocinstall:

From the Apache website: http://tomcat.apache.org/download-70.cgi
Run
c:ocinstall apache-tomcat-7.0.52.exe
The Apache Tomcat Setup Installation Wizard opens.
When the Open File - Security Warning message displays, click Run.2.
On the Welcome screen of the Apache Tomcat Setup Installation Wizard, click Next.3.
The License Agreement screen displays.
Click I Agree to accept the agreement.4.
The Choose Components screen displays.
Click Next to accept the default values.5.
The Configuration screen displays.
Click Next to accept the default values.6.

http://tomcat.apache.org/download-70.cgi


The Java Virtual Machine screen displays.
Click ..., then select the path you installed the JDK into:7.
c:oc jdk1.7.0_51
The screen now should look like this:

Click Next.8.
The Choose Install Location screen displays
Edit the Destination Folder to be c:octomcat. The screen should look like this:9.

Click Install to start the installation.10.
When the installation is finished, the Completing the Apache Tomcat Setup Wizard screen
displays.



Complete the screen as follows:11.
0. Clear the Run Apache Tomcat checkbox.
1. Clear the Show Readme checkbox.
The screen should now look like this:

Click Finish.12.
Create the directory c:octomcatoldwebapps.13.
Move the web apps provided with Tomcat that OpenClinica does not need by moving the14.
contents of c:octomcatwebapps to c:octomcatoldwebapps.

9.3.6 Starting and Stopping Tomcat

Start Tomcat using any one of these methods:

From the Apache Tomcat 7 Properties window:1.
Select Start > Apache Tomcat 7.0 > Configure Tomcat to open the window.1.
Click the General tab.2.
On the General page, click the Start button to start Tomcat.3.

Using the Windows run command:2.
Select Start > Run.1.
In the Run box, type cmd, then click OK.2.
At the new command prompt, start Tomcat by typing3.

net start tomcat7
then press Enter.

When you need to stop Tomcat, type
net stop tomcat7
then press Enter.

9.3.6 Install OpenClinica Package

Download the OpenClinica software, OpenClinica-v.x.y.zip, from the OpenClinica website1.



location, https://community.openclinica.com/project/openclinica. To download the software,
you need a community account, which is free to create. You will be required to log in to this
account to download the OpenClinica software.
After downloading the OpenClinica software, move it to the directory with the other software
dependencies you downloaded:
c:ocinstall.
Right-click OpenClinica-v.x.y.zip and select Extract All.2.
The Extraction Wizard opens.
Click Next.3.
In the next screen, change the directory to c:ocinstall, and click Next.4.
In the next screen, clear the Show Extracted Files checkbox, and click Finish.5.
Copy c:ocinstallOpenClinica-v.x.ydistributionOpenClinica.war to c:octomcatwebapps.6.

9.3.7 Set Up the PostgreSQL Database

Complete these instructions to setup PostgreSQL database.

Select Start > Programs > PostgreSQL 8.4 > pgAdminIII.1.
The pgAdminIII window opens. Right-click the PostgreSQL 8.4 (localhost:5432) icon, and2.
select Connect, as shown here:

Log in to the database server using the password you set up during the PostgreSQL3.
installation.
Create the database openclinica and the database user clinica, which OpenClinica uses to4.
connect to the database:
0. Expand the databases, and select postgreSQL.
1. Select Tools > Query tool.
The Query window opens.
2. In the SQL Editor box, delete all the text.
3. In the SQL Editor box, type the following:
CREATE ROLE clinica LOGIN ENCRYPTED PASSWORD 'clinica' SUPERUSER NOINHERIT
NOCREATEDB NOCREATEROLE;
4. Select Query > Execute, which runs the SQL query.

https://community.openclinica.com/project/openclinica


When the query completes, a message displays in the History window.
5. In the SQL Editor box, delete all the text.
6. In the SQL Editor box, type the following:
CREATE DATABASE openclinica WITH ENCODING='UTF8' OWNER=clinica;
7. Select Query > Execute.
When the query completes, a message displays in the History window.
8. Close the Query window, and click No when prompted to save changes.
The database password is set to clinica by default, which is not a secure password. Change the5.
password as follows:

In the pgAdminIII window, expand and select Login Roles.1.
Select View > Refresh.2.
The clinica database user is listed.3.
Right-click the clinica user account and select Properties.4.
In the Login Role for clinica box that displays, enter the new password and re-enter it,5.
then click OK.   Record the password for future use.

9.3.8 Configure Tomcat to Work with OpenClinica and (if installed) OpenClinica Web
Services

Select Start>All Programs > Apache Tomcat 7.0 > Configure Tomcat.1.
The Apache Tomcat 7 Properties window opens.
Please click the Java Options tab described in the 'Configure Tomcat' section and add the2.
following
-XX:+UseParallelGC
-XX:ParallelGCThreads=n
-XX:MaxPermSize=180m
-XX:+CMSClassUnloadingEnabled
 On Java Console set Maximum Pool Size to 1280.
Please note that the minimum RAM requirement is 1280 MB of memory for these settings, so
the CPU is expected to have much higher RAM available.
Where n is the number of cores of your CPU.  There should be no spaces before or after each
entry. Each entry should be on a new line. The MaxPermSize value depends on the number of
.war files that you are deploying. For instance, if you deploy web and web services,
XX:MaxPermSize should be set to 360m.
 -XX:ParallelGCThreads = # of cores of your CPU, as long as the number of processors on your
CPU are lesser than 8.The Window should look like this for a 4 core processor:
This setting is based upon the number of war files deployed. The web war needs a 180m of
PermGen and the ws war needs a 90m of PermGen memory settings.
The window should now look like this:3.



Click Apply, which completes the configuration of Tomcat.4.
Start Tomcat:5.

Click the General tab.1.
On the General page, click Start.2.

In about five minutes, Tomcat will be fully started. Verify it is fully started by opening the file6.
c:octomcatlogstomcat7-stderr.current date.out, and looking for this line:
INFO: Server Startup in XXXXX ms
After verifying Tomcat has fully started, in the General page of the Apache Tomcat 77.
Properties window, click Stop.
Wait two minutes for Tomcat to stop, then delete OpenClinca.war from c:octomcatwebapps.8.

9.3.9 Configure the OpenClinica Application

If you followed all the previous instructions exactly, there is only one property in the configuration
file, datainfo.properties, that you may need to change in order for OpenClinica to start. There are
other properties in the configuration file you will probably want to modify for your system, however.

Using WordPad, open the configuration file:1.
c:octomcatwebappsOpenClinicaWEB-INFclassesdatainfo.properties
Edit values for the properties in the datainfo.properties file. You must change the value for2.
dbPass to the password you selected when you set-up PostgreSQL. Change the values for any
other properties. The datainfo.properties file for Windows is the same as for Linux.
When you finish making changes, save the file.3.
You may also need to configure OpenClinica for internationalization should you wish to utilize4.
OpenClinica in different languages. Also, if you need to use some UTF-8 characters in your
application, you may need to modify your default connecter configuration. For more
information regarding configuring OpenClinica for internationalization and using UTF-8
characters, please refer to
https://docs.openclinica.com/3-1-technical-documents/openclinica-and-internationalization/.

https://docs.openclinica.com/3-1/installation/3-1-installation-install-3-1-x-linux/3-1-installation-installation-linux-download-installation-files/#content-title-4337#content-title-5457#content-title-5457#content-title-5457%20#content-title-5457#content-title-5457%20#content-title-4343%20#content-title-4343%20#content-title-4343%20#content-title-4343%20#content-title-5457%20#content-title-4342#content-title-4343%20
https://docs.openclinica.com/3-1-technical-documents/openclinica-and-internationalization/


9.3.10 Verify the Installation

At this point, Java, Tomcat, PostgreSQL, and OpenClinica are installed and set up. Verify the
installation was successful by following these steps:

Restart Tomcat1.
Open a web browser and access OpenClinica at the following URL:2.

http://localhost:8080/OpenClinica

(The port number may be different if you changed the configuration of your Tomcat instance
that is running OpenClinica.)  The OpenClinica Login page should display.
Log in to OpenClinica using the default user name, root, and password 12345678. You will be3.
forced to change the password for the user "root" to a secure password. See Update User
Profile if you need more information.
The user "root" is assigned to a default Study named "Default." Create a user account for4.
yourself, with the User Type set to "technical administrator" and the User Role set to Data
Manager: for instructions to create the user account, see Create a New User.
Log out and stop Tomcat if you now plan to install Web Services Package5.

9.3.11 Install OpenClinica Web Services Package

Web Services are optional. You do not need to install them if you are not planning on using web
services.

Download the OpenClinica-ws software, OpenClinica-ws-v.x.y.zip, from the OpenClinica1.
website location: https://community.openclinica.com/project/openclinica. To download the
software, you need a community account, which is free to create. You will be required to log in
to the account to download the OpenClinica software. After downloading the OpenClinica-ws
software, move it to the directory with the other software dependencies you downloaded:
c:ocinstall.
Right-click OpenClinica-ws-v.x.y.zip and select Extract All.2.
The Extraction Wizard opens.3.
Click Next.4.
In the next screen, change the directory to c:ocinstall, and click Next.5.
In the next screen, clear the Show Extracted Files checkbox, and click Finish.6.
Copy c:ocinstallOpenClinica-ws-v.x.ydistributionOpenClinica-ws.war to c:octomcatwebapps.7.
Restart Tomcat then stop Tomcat following the intructions from above.8.

9.3.12 Configure OpenClinica Web Services

If you followed all the previous instructions exactly, there is only one property in the configuration
file, datainfo.properties, that you may need to change in order for OpenClinica Web Services to
start. There are other properties in the configuration file you will probably want to modify for your
system, however.
Note: Most of the properties are not needed or used for Web Services.

Using WordPad, open the configuration file:1.
c:octomcatwebappsOpenClinica-wsWEB-INFclassesdatainfo.properties
Edit values for the properties in the datainfo.properties file. You must change all values from2.
Database Configuration section of datainfo.properties file to reflect your settings in
datainfo.properties file for OpenClinica application. Change the values for any other

https://docs.openclinica.com/3.1/openclinica-user-guide/working-openclinica#content-title-3603
https://docs.openclinica.com/3.1/openclinica-user-guide/working-openclinica#content-title-3603
https://docs.openclinica.com/3.1/administer-users#content-title-2979
https://community.openclinica.com/project/openclinica
https://docs.openclinica.com/install-3-2-linux


properties.

The datainfo.properties file for Windows is the same as for Linuxsee more information at
description of datainfo.properties file for web services.
If you are installing Web Services for OpenClinica 3.1.2 and earlier please edit adminEmail3.
property (section 5 - adminEmail) if you would like e-mail to be send through 'Contact' link
from Web Services welcome page.
Other properties that can be configured for web services are:4.
0. Section 11 - Logging configuration
When you finish making changes, save the file.5.

9.3.13 Verify the Installation of OpenClinica Web Services

Restart Tomcat1.
Point your web browser to the OpenClinica Web Services welcome page: http://<<server2.
url>>:8080/OpenClinica-ws. The OpenClinica Web Services Welcome page should be display.
Verify the version number is v.x.x-Community, where v.x.x is the version number you upgraded3.
OpenClinica Web Services to. The version number is displayed in the lower right corner of the
page.

Web Services should have the same version as OpenClinica application.

Functional approval by Rahul Sundaram. Signed on 2014-07-21 3:30PM

Approved for publication by Ben Baumann. Signed on 2014-07-21 3:32PM

Not valid unless obtained from the OpenClinica document management system on the day of
use.

10.10 Upgrade to OpenClinica 3.2 on Linux
The following process describes how to upgrade Java and Tomcat to work with OpenClinica 3.2 on
Linux. Be sure to back up your database before starting the upgrade process.

Before you begin, the following packages should be installed with your Linux operating system:
    vim
    unzip
    tar
(eg:~# apt-get install vim)

You will require "root" user access to your operating system. Run all commands in this guide with a
user account possessing root-level permissions.

9.3.1 Upgrade Java 6 to Java 7

9.3.1.1 Preconditions for Upgrading Java

Access OpenClinica at the following URL:1.
http://localhost:8080/OpenClinica
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The Login page should display.

Verify the current version of Java is Java 6 by running this command:2.

/usr/local/java/jre/bin# ./java version

 9.3.1.2 Upgrade Java 6 to Java 7

a. For 32-bit operating systems, to get the files from OpenClinica, run:

    wget https://dev.openclinica.com/oc/software/OpenClinica-3.2/linux/jdk-7u51-linux-i586.gz

b. For 64-bit operating systems, to get the files from OpenClinca, run:

    wget https://dev.openclinica.com/oc/software/OpenClinica-3.2/linux/jdk-7u51-linux-x64.gz

The OpenClinica software is written in the Java programming language, so you must have Java
installed on your system in order to run the OpenClinica application.

Install Java by running:1.

ar -xvf jdk-7u51-linux-x64.tar.gz       (This command is to unzip gz)

chown R root:root jdk1.7.0_51            ( to change owner)

chmod a+x jdk-7*     

 To install the Java in operating system by running2.
        
mv jdk1.7* /usr/local/
        
ln -s /usr/local/jdk1.7* /usr/local/java

Java is now installed in the correct location. 

9.3.1.3 Verify Java 7 is installed

Verify the current version of the Java is Java 7 by running these commands in root:1.

Goto: cd /usr/local/java/jre/bin

Run:  ./java version
(for example: root@bagel:/usr/local/java/jre/bin# ./java version)
Access OpenClinica at the following URL:2.
http://localhost:8080/OpenClinica
The Login page should display.

 9.3.2 Upgrade Tomcat 6 to Tomcat 7

9.3.2.1 Preconditions for Upgrading Tomcat



Access OpenClinica at the following URL:1.
http://localhost:8080/OpenClinica
The Login page should display.
Stop Tomcat 6 by running the following command:2.

/etc/init.d/tomcat stop
Uninstall Tomcat 6 from your system (including all the configuration files) but3.
Before running this command make sure that ,  cd /usr/local.

rm rf tomcat

rm rf apache-tomcat-6.0.32

9.3.2.2 Install Tomcat 7

The OpenClinica software uses the Apache Tomcat Java application server.1.
Download Tomcat 7 from one of the following sites and copy it into the local folder
/usr/local/oc/install/
Download it from the Tomcat website: http://tomcat.apache.org/download-70.cgi
- or -
Download it from the OpenClinica website: 
https://dev.openclinica.com/oc/software/OpenClinica-3.2/linux/apache-tomcat-7.0.5
2.tar.gz
Run the following command in /usr/local/oc/install/ to install Tomcat 7.
wget
https://dev.openclinica.com/oc/software/OpenClinica-3.2/linux/apache-tomcat-7.0.5
2.tar.gz
The current directory on your system should be /usr/local/oc/install. If it is not,2.
make it the current directory by running:
cd /usr/local/oc/install
Install Tomcat by running the following:3.

tar -zxvf apache-tomcat-7*

mv apache-tomcat-7.0.52 /usr/local/

ln -s /usr/local/apache-tomcat-7.0.52 /usr/local/tomcat

(Note: The system will prompt you to enter your UNIX password. Use tomcat as
the password, and press enter for all the default value for the full name, room
number, phone, home phone and other. Is the info correct? Type Y and enter.)
Move the web apps provided with Tomcat that are not needed by OpenClinica to4.
another location by running:

mkdir /usr/local/tomcat/oldwebapps

mv /usr/local/tomcat/webapps/* /usr/local/tomcat/oldwebapps

Tomcat is now installed and you can set Tomcat to automatically start when you
start your system, or you can start Tomcat manually by issuing commands.

http://tomcat.apache.org/download-70.cgi
https://dev.openclinica.com/oc/software/OpenClinica-3.2/linux/apache-tomcat-7.0.52.tar.gz
https://dev.openclinica.com/oc/software/OpenClinica-3.2/linux/apache-tomcat-7.0.52.tar.gz


To set Tomcat to start automatically on system startup, run the following: (Note:
Before running the command install the OpenClinica 3.2 on your install folder)

cp /usr/local/oc/install/OpenClinica-3.2*/install-docs/linux/tomcat /etc/init.d/

cd /etc/init.d

chmod a+x /etc/init.d/tomcat

/sbin/chkconfig --add tomcat

(Note: This command is only for Red Hat Linux. For other operating systems, see
the operating system instructions for adding an init script.)

Update the File Path parameter to the correct value5.

chown -R tomcat /usr/local/tomcat/*

chown -R tomcat /usr/local/apache-*

9.3.2.3 Deploy the OpenClinica Software Package

        First, make sure Tomcat is stopped:

Stop Tomcat 7 by running:1.
/etc/init.d/tomcat stop
The current directory on your system should be /usr/local/oc/install. If it is not,2.
make it the current directory by running:
cd /usr/local/oc/install
Run each of the following commands:3.

unzip OpenClinica 3.2*

cd OpenClinica 3.2*/distribution

unzip OpenClinica.war -d OpenClinica

cp -rf OpenClinica* /usr/local/tomcat/webapps

rm -f /usr/local/tomcat/webapps/OpenClinica.war

OpenClinica is now deployed for use with the database.

9.3.2.4 Verify Tomcat 7 is Started and the Application is Running

Start Tomcat:1.
/etc/init.d/tomcat start
(Note: Replace start with stop to stop the Tomcat service)
Verify Tomcat 7 is running with the following commands. You should see a similar2.
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message as shown in the bracket().
/etc/init.d/tomcat status  (Tomcat is running)
Access OpenClinica at the following URL:3.
http://localhost:8080/OpenClinica
The Login page should display.

Approved for publication by Ben Baumann. Signed on 2014-03-27 5:45PM

Not valid unless obtained from the OpenClinica document management system on the day of
use.

10.11 Upgrade to OpenClinica 3.2 on
Windows
9.4.1 Upgrade Java 6 to Java 7

9.4.1.1 Preconditions for Upgrading Java

Verify Java 6 (jdk1.6.0_24) is already installed and running.1.
Go to Start>All Programs>Java Folder. Click About Java.
Verify the current version of Java is 6 (jdk1.6.0_24).
Verify the following directory exists c:ocinstall. If it does not, then create the directory.2.
Open a web browser and access OpenClinica at the following URL:3.
http://localhost:8080/OpenClinica
The OpenClinica login page should display.

9.4.1.2 Upgrade Java 6 to Java 7

From one of the following websites, download the Java 7 SE Development Kit 7.0 update1.
(jdk-7u51-windows-i586.exe ) and save it to c:ocinstall:

From the Java website:
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.htm
l
From the OpenClinica website:
http://svn.akazaresearch.com/oc/software/OpenClinica-3.2/windows/

Run c:ocinstalljdk-7u51-windows-i586.exe.2.
The installation window starts and looks like:3.

http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html
http://svn.akazaresearch.com/oc/software/OpenClinica-3.2/windows/


Click Next4.
The Custom Setup screen displays.5.
a. Click Change....
b. Change the path to c:oc jdk1.7.0_51, then click OK.
The Custom Setup screen should now look like this:

Click Next6.
Java Setup-Destination Folder will show up. Keep the default location and click Next7.
The Setup Wizard installs the JDK.8.
The Install Success screen displays.9.
Click Close.10.

9.4.1.3 Verify Java 7 is installed

Verify Java 7 (jdk1.7.0_51) has been installed and running. Also, please notice that all1.
applications, not specified with Java 6, will use Java 7 after the upgrading.
Go to Start>All Programs>Java Folder. Click About Java.
Verify the current version of Java is 7 (jdk1.7.0_51). The updated About Java screen should



look as below:

Verify Java 7 is installed by opening a web browser and accessing OpenClinica at the following URL:
http://localhost:8080/OpenClinica
The OpenClinica login page should display

9.4.2 Upgrade Tomcat6 to Tomcat7

9.4.2.1 Preconditions for Upgrading Tomcat

First, open a web browser and verify you can access OpenClinica at the following1.
URL: http://localhost:8080/OpenClinica
The OpenClinica login page should display.
To upgrade the Tomcat 6 to Tomcat 7, you need to first remove Tomcat 6:2.

Stop Tomcat 6 using any one of these methods:

From the Apache Tomcat 6 Properties window:1.
Select Start > Apache Tomcat 6.0 > Configure Tomcat to open the
window.
Click the General tab.
On the General page, click the Stop button to stop Tomcat

Using the Windows run command:2.
Select Start > Run.
In the Run box, type cmd, then click OK.

At the new command prompt, stop Tomcat by typing

net stop tomcat6

Then press Enter.

a. Uninstall Tomcat 6
Select Start > Control Panel > Add Remove Programs, then remove Tomcat 6 by pressing
uninstall program.

b. Reboot the system



After removing the Tomcat6 from the program, reboot the system.

9.4.2.2 Install Tomcat 7

From either of the following two websites, download the Windows Service Installer1.
Version, apache-tomcat-7.0.52.exe, and save it to c:ocinstall:

Download from the Apache website: http://tomcat.apache.org/download-70.cgi
Download from the OpenClinica website:
http://svn.akazaresearch.com/oc/software/OpenClinica-3.2/windows/

Run the Installation file:2.
c:ocinstallapache-tomcat-7.0.52.exe
The Apache Tomcat Setup Installation Wizard opens.
When the Open File - Security Warning message displays, click Run.
On the Welcome screen of the Apache Tomcat Setup Installation Wizard, click
Next.
The License Agreement screen displays. Click I Agree to accept the agreement.
The Choose Components screen displays. Click Next to accept the default values.
The Configuration screen displays. Click Next to accept the default values.
The Java Virtual Machine screen displays. Click ..., then select the path where you
installed the JDK:
c:oc jdk1.7.0_51
The screen now should look like this:

Click Next.

The Choose Install Location screen displays. Edit the Destination Folder
to be c:octomcat. The screen should look like this:

http://tomcat.apache.org/download-70.cgi
http://svn.akazaresearch.com/oc/software/OpenClinica-3.2/windows/


Click Install to start the installation.
When the installation is finished, the Completing the Apache Tomcat
Setup Wizard screen displays.Complete the screen as follows:
-Clear the Run Apache Tomcat checkbox.
-Clear the Show Readme checkbox.
The screen should now look like this:

Click Finish.



9.4.2.3 Deploy the OpenClinica Package

Download the OpenClinica software package, OpenClinica 3.2.zip, from the1.
OpenClinica website: https://community.openclinica.com/project/openclinica. To
download the software, you need a community account, which is free to create.
You will be required to log in to the account in order to download the OpenClinica
software.

After downloading the OpenClinica software, move it to the directory with
the other software dependencies you downloaded:
c:ocinstall.

Right-click OpenClinica 3.2.zip and select Extract All.1.
The Extraction Wizard opens.
Click Next2.
In the next screen, change the directory to c:ocinstall, and click Next.3.
In the next screen, clear the Show Extracted Files checkbox, and click Finish.4.
Stop Tomcat. At the new command prompt, stop Tomcat by typing:5.
net stop tomcat7
Copy c:ocinstallOpenClinica 3.2distributionOpenClinica.war to6.
c:octomcatwebapps.

9.4.2.4 Verify Tomcat 7 is installed and Application is Running

a. Start Tomcat

Verify that Tomcat is running. If Tomcat is not started than start Tomcat
using any one of these methods:

From the Apache Tomcat 7Properties window:1.
Select Start > Apache Tomcat 7.0 > Configure Tomcat to
open the window.
Click the General tab.
On the General page, click the Start button to start Tomcat.

Using the Windows run command:2.
Select Start > Run.
In the Run box, type cmd, then click OK.
At the new command prompt, start Tomcat by typing
net start tomcat7
then press Enter.

b. Verify the OpenClinica Application

Open a web browser and access the OpenClinica at the following URL:
http://localhost:8080/OpenClinica
The OpenClinica login page should display.

https://community.openclinica.com/project/openclinica
https://www.openclinica.com/cas/login?service=https://community.openclinica.com/cas?destination=https://www.openclinica.com/
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10.12 Install OpenClinica 3.1.x on Linux
These instructions have been verified for Red Hat Enterprise Linux version 5.

These instructions are for installing version 3.1 of OpenClinica, and also apply to installing the
maintenance releases of 3.1 for example 3.1.2. When you see v.x or v.x.y in the instructions, use your
version number, e.g. 3.1.2.

Approved for publication by Ben Baumann. Signed on 2014-03-27 9:15AM

Not valid unless obtained from the OpenClinica document management system on the day of
use.

10.12.1 Overview of Installation on Linux
Systems
Use the following process to acquire, install, and configure OpenClinca and its software
dependencies. In each step, click the link to view detailed instructions for that step:

Ensure your operating system meets the specified requirements1.
Download the installation files2.
Install Java3.
Install Tomcat4.
Install the database you will use, either PostgreSQL or Oracle:5.

Follow these instructions to install PostgreSQL.
If you are using Oracle, you will need to obtain the instructions to install it. OpenClinica
does not provide instructions to install Oracle.

Set up the database you installed:6.
Set up PostgreSQL
Set up Oracle

Deploy OpenClinica within Tomcat7.
Set Tomcat to start8.
Configure the OpenClinica application9.
Restart the system and verify access to OpenClinica10.
Configure Tomcat to use HTTPS11.
Verify the installation by ensuring you can log in to OpenClinica.12.

After completing the OpenClinica installation, see the Overview of OpenClinica for instructions to
start using the application. A good first step is to define one or more users (especially a Study
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Director) and then build a Study.

10.12.2 Operating System Requirements
The following packages should be installed for your Operating System:

vim
unzip
tar

You require "root" user access. Run all commands in the installation instructions using root-level
permission.

10.12.3 Download Installation Files
OpenClinica and OpenClinica Web Services run and depend on several external software
technologies: the Java Development Kit, the Apache Tomcat Servlet Container, and the PostgreSQL
relational database (unless you are using the Oracle database).

The OpenClinica website has a copy of the neccessary installers for Java, Tomcat, and PostgreSQL
for you to download. If you choose to use versions of Java, Tomcat, and PostgreSQL other than those
provided on the website, please note that they have not been tested with the OpenClinica
application.

There are 32-bit and 64-bit editions of the software, when applicable. To determine if your system is
running a 32-bit or 64-bit operating system, in your Linux terminal, run

uname -a

The display reports the version:

If i386 or i686 displays, it is a 32-bit operating system.
If x86_64 displays, it is a 64-bit operating system.

To download the installation files:

Run the following commands to create the OpenClinica directory on your system and to make1.
it the current directory:

mkdir -p /usr/local/oc/install
cd /usr/local/oc/install

Run the following commands to download the Java, Tomcat, and PostgreSQL files for your2.
architecture. In the commands, substitute v.x with the version of OpenClinica you are
installing ( e.g. 3.1):

For 32-bit operating systems, to get the files from OpenClinica run:

wget
http://svn.akazaresearch.com/oc/software/OpenClinica-3.1/linux/apache-tomcat-6.0.32.ta
r.gz



wget http://svn.akazaresearch.com/oc/software/OpenClinica-3.1/linux/jdk-6u24-linux-
i586.bin

If you will be using PostgreSQL (not Oracle) for your database, also run:

wget http://svn.akazaresearch.com/oc/software/OpenClinica-3.1/linux/postgresql-8.4.1-1-
linux.bin

For 64-bit operating systems, to get the files from OpenClinca, run:

wget http://svn.akazaresearch.com/oc/software/OpenClinica-3.1/linux/apache-
tomcat-6.0.32.tar.gz

wget http://svn.akazaresearch.com/oc/software/OpenClinica-3.1/linux/jdk-6u24-linux-
x64.bin

If you will be using PostgreSQL (not Oracle) for your database, also run:

wget http://svn.akazaresearch.com/oc/software/OpenClinica-3.1/linux/postgresql-8.4.1-1-
linux-x64.bin

Instead of downloading the files from the above links, you can download them directly
from their native websites:

PostgreSQL: http://www.postgresql.org/

Java: http://www.oracle.com/technetwork/java/index.html

Tomcat: http://tomcat.apache.org/

Download the OpenClinica software from the OpenClinica website, using this location:3.
https://community.openclinica.com/project/openclinica. To download the software, you need a
OpenClinica community user account, which is free to create; you will be required to log in to
the account to download the OpenClinica software.

After downloading the OpenClinica software, move it to the directory where you downloaded
the other software components to:

/usr/local/oc/install

10.12.4 Install Java
The OpenClinica software is written in the Java programming language, so you must have Java
installed on your system in order to run the OpenClinica application.

The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

cd /usr/local/oc/install

http://www.postgresql.org/
http://www.oracle.com/technetwork/java/index.html
http://tomcat.apache.org/
https://community.openclinica.com/project/openclinica
https://community.openclinica.com/user/register


Install Java by running:2.

chmod a+x jdk-6*
./jdk-6*

When the files finish extracting, the system displays "Press Enter to continue ...," press Enter.3.
A web browser window opens, presenting you with the option to register the Java software.4.
Register, or close the window.

Install Java in the operating system by running:5.

mv jdk1* /usr/local/
ln -s /usr/local/jdk1* /usr/local/java

Java is now installed in the correct location.

10.12.5 Install Tomcat
The OpenClinica software uses the Apache Tomcat Java application server.

The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

cd /usr/local/oc/install

Install Tomcat by running the following:2.

tar -zxvf apache-tomcat-*
mv apache-tomcat-6.0.32 /usr/local/
ln -s /usr/local/apache-tomcat-6.0.32 /usr/local/tomcat
/usr/sbin/adduser tomcat

Move the web apps provided with Tomcat that are not needed by OpenClinica to another3.
location by running:

mkdir /usr/local/tomcat/oldwebapps
mv /usr/local/tomcat/webapps/* /usr/local/tomcat/oldwebapps

Tomcat is now installed.

10.12.6 Install PostgreSQL Database
The OpenClinica software uses an underlying relational database management system, either
PostgreSQL or Oracle. Complete these instructions if you will be using the PostgreSQL database. If
you will be using the Oracle database, install Oracle instead of completing these instructions. Note:
we do not provide instructions for installing Oracle.

The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

http://tomcat.apache.org/


cd /usr/local/oc/install

Start the PostgreSQL setup by running:2.

chmod a+x postgresql-8.4.*
./postgresql-8.4.* --mode text

The PostgreSQL Setup Wizard starts.

For most of the options in the Setup Wizard, accept the defaults. Complete the Setup Wizard3.
as follows:

Prompt Action
Installation Directory [/opt/PostgreSQL/8.4] Press Enter to accept.
Data Directory [/opt/PostgreSQL/8.4/data] Press Enter to accept.

Password
Enter a password for the PostgreSQL
database superuser, then press Enter.
Record the password because you will
need it again in this installation.

Retype Password Type the password again, then press
Enter.

Port [5432] Press Enter to accept.
Please choose an option [1] Press Enter to accept.
Install pl/pgsql in template1 database? [Y/n] Type n, then press Enter.
Do you want to continue? [Y/n] Press Enter to accept.
Setup has finished installing PostgreSQL on your
computer.

Stack Builder may be used to download and install
additional tools, drivers and applications to
complement your PostgreSQL installation. [Y/n]

Type n, then press Enter.

       

PostgreSQL is now installed on your system and will start when you start up your system.

10.12.7 Set Up the PostgreSQL Database
Complete these instructions if you will be using the PostgreSQL database. If you will be using the
Oracle database, instead use the Oracle setup instructions.

Run the following commands to create the PostgreSQL database and database user1.
OpenClinica uses to connect to the database:

/opt/PostgreSQL/8.4/bin/psql -U postgres -c "CREATE ROLE clinica LOGIN ENCRYPTED
PASSWORD 'clinica' SUPERUSER NOINHERIT NOCREATEDB NOCREATEROLE"

/opt/PostgreSQL/8.4/bin/psql -U postgres -c "CREATE DATABASE openclinica WITH
ENCODING='UTF8' OWNER=clinica"

https://docs.openclinica.com/3-1/installation/3-1-installation-oracle-database-setup/


The database user password is set to clinica by default, which is not a secure password.2.
Change the password as follows:

Run:1.

/opt/PostgreSQL/8.4/bin/psql -U postgres

A psql prompt displays with this message:2.

ALTER USER clinica WITH PASSWORD 'XXXX'

Replace XXXX with a secure password. Record the password for use in a later3.
installation step.

Exit the psql prompt by running:4.

q

10.12.8 Deploying OpenClinica within
Tomcat

The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

cd /usr/local/oc/install

Run the following commands. In the commands, v.x is your version of OpenClinica, e.g. 3.1:2.

unzip OpenClinica-v.x*
cd OpenClinica-v.x*/distribution
unzip OpenClinica.war -d OpenClinica
cp -rf OpenClinica* /usr/local/tomcat/webapps
rm -f /usr/local/tomcat/webapps/OpenClinica.war

OpenClinica is now deployed for use with the database.

10.12.9 Deploying OpenClinica Web Services
within Tomcat
Web Services are optional. Do not install them if you are not planning to use them.

The current directory on your system should be /usr/local/oc/install. If it is not, make it the1.
current directory by running:

cd /usr/local/oc/install

Run the following commands. In the commands, v.x is your version of OpenClinica, e.g. 3.1:2.



unzip OpenClinica-ws-v.x*
cd OpenClinica-ws-v.x*/distribution
unzip OpenClinica-ws.war -d OpenClinica-ws
cp -rf OpenClinica* /usr/local/tomcat/webapps
rm -f /usr/local/tomcat/webapps/OpenClinica-ws.war

OpenClinica web services are now deployed for use with the database.

10.12.10 Set Tomcat to Start
You can set Tomcat to automatically start when you start your system, or you can start and stop
Tomcat manually by issuing commands.

To set Tomcat to start automatically on system startup, run the following:

cp /usr/local/oc/install/OpenClinica-v.x*/install-docs/linux/tomcat /etc/init.d/

cd /etc/init.d

chmod a+x /etc/init.d/tomcat

/sbin/chkconfig --add tomcat (Note: This command is only for Red Hat Linux. For other operating
systems, see the operating system instructions for adding an init script.)

To stop and start Tomcat manually by issuing commands, run the following:

/usr/local/tomcat/bin/shutdown.sh (stops Tomcat)

/usr/local/tomcat/bin/startup.sh (starts Tomcat)

10.12.11 Configure OpenClinica for Optimum
Performance
Under stress tests, OpenClinica 3.1.3 has performed well with the following JVM (Java Virtual
Machine) settings: 

Edit the init.d/tomcat and replace the JAVA_OPTS with following:

export JAVA_OPTS="$JAVA_OPTS   -Xmx1280m -XX:+UseParallelGC -XX:ParallelGCThreads=n -
XX:MaxPermSize=180m -XX:+CMSClassUnloadingEnabled"

For the setting -XX:ParallelGCThreads=n, n should be replaced with the # of cores of your CPU as
long as the total number of cores are lesser than 8.

The number of cores can be determined by using 'top' command.

Please note that the minimum RAM requirement is 1280 MB of memory for these settings, so the
server is expected to have much higher RAM available. The amount of available memory can be



determined by using the command free -m to give the memory (in MB). The MaxPermSize value
depends on the number of war files that you are deploying. The web war needs a 180m of PermGen
and the ws war needs a 90m of PermGen memory settings.

For the settings to take effect, restart the Tomcat server.

10.12.12 Configure the OpenClinica
Application
If you followed all the previous instructions exactly, there is only one property in the configuration
file, datainfo.properties, that you may need to change in order for OpenClinica to start. There are
other properties in the configuration file you will probably want to modify for your system.

Open the configuration file: /usr/local/tomcat/webapps/OpenClinica/WEB-1.
INF/classes/datainfo.properties
Edit values for the properties in the datainfo.properties file. You must change the value for2.
dbPass to the password you selected in Set Up the PostgreSQL Database. Change the values
for any other properties, then save the file.
Update the filePath parameter to the right value.3.
Run the following commands:4.

chown -R tomcat /usr/local/tomcat/*
chown -R tomcat /usr/local/apache-*
You may also need to configure OpenClinica for internationalization should you wish to utilize5.
OpenClinica in different languages. Also, if you need to use some UTF-8 characters in your
application, you may need to modify your default connecter configuration. For more
information regarding configuring OpenClinica for internationalization and using UTF-8
characters, please refer to
 https://docs.openclinica.com/3.1/technical-documents/openclinica-and-internationalization

10.12.13 Configure the OpenClinica Web
Services
If you followed all the previous instructions exactly, there is only one property in the configuration
file, datainfo.properties, that you may need to change in order for OpenClinica Web Services to
start. There are other properties in the configuration file you will probably want to modify for your
system.

Note: Most of the properties are not needed or used for Web Services, see Description of
datainfo.properties File for Web Services for more information on what settings are actually used.

Open the configuration file: /usr/local/tomcat/webapps/OpenClinica-ws/WEB-1.
INF/classes/datainfo.properties
Edit values for the properties in the datainfo.properties file. You must change all values from2.
Database Configuration section of datainfo.properties file to reflect your settings in
datainfo.properties file for OpenClinica application. Change the values for any other
properties. 
Run the following commands:3.

https://docs.openclinica.com/3-1/installation/3-1-installation-install-3-1-x-linux/3-1-installation-installation-linux-download-installation-files/#content-title-4337#content-title-5457#content-title-5457#content-title-5457%20#content-title-5457#content-title-5457%20#content-title-4343%20#content-title-4343%20#content-title-4343%20
https://docs.openclinica.com/3.1/technical-documents/openclinica-and-internationalization
https://docs.openclinica.com/3-1/installation/3-1-installation-install-3-1-x-linux/3-1-installation-installation-linux-download-installation-files/#content-title-4337#content-title-5457
https://docs.openclinica.com/3-1/installation/3-1-installation-install-3-1-x-linux/3-1-installation-installation-linux-download-installation-files/#content-title-4337#content-title-5457
https://docs.openclinica.com/3-1/installation/3-1-installation-install-3-1-x-linux/3-1-installation-installation-linux-download-installation-files/#content-title-4337#content-title-5457


chown -R tomcat /usr/local/tomcat/*
chown -R tomcat /usr/local/apache-*

 

10.12.14 Description of datainfo.properties
File
The datainfo.properties file will look similar to the following. Each group of properties is numbered
and a description of the property group is presented as a series of comment lines (lines that begin
with # are comments) before the section where you specify the values for the properties in the
group.

#############################################################
################
# 1 - Database Configuration
#
# Database configuration is done with the following 6 properties
# The dbType options are either postgres or oracle.
# Enter the user name and password to access the database in
# dbUser and dbPass.
# The db field is for the name of the database and provide the port
# in dbPort.
# dbHost can be a URL, IP address or localhost
#
# REQUIRED
#############################################################
################
dbType=postgres
dbUser=clinica
dbPass=clinica
db=${WEBAPP.lower}
dbPort=5432
dbHost=localhost

#############################################################
################
# 2 - filePath
#
# File Path is the string which declares the
# repository for all uploaded and generated
# files in the system, including CRFs and
# data sets.  The directory should NOT be
# accessible by the web server.
#
# REQUIRED.  
#############################################################
################
filePath=${catalina.home}/${WEBAPP.lower}.data/



#############################################################
################
# 3 - Attached File Location
# Location for files if item data type is "file". If it has been kept empty,
# "filePath" will be used as the attached file location.
# This will be a sub folder within the filePath location only.
# You may configure a full path that points to a directory outside of the filePath.
# If you configure a full path, it must have a trailing slash.
# Example = /usr/local/attached_file/ or C:\attached_file\
#
# NOT REQUIRED
#############################################################
################
# attached_file_location=

#############################################################
################
# 4 - user_account_notification
#
# User Account Notification is the method by
# which new users are sent their passwords.
# Users can be sent passwords via email,
# or the password can be displayed on the screen
# to the administrator, who is instructed to
# write it down and physically give it to the user
# in question.  The default is email.
#
# REQUIRED.  
#############################################################
################
userAccountNotification=email

#############################################################
################
# 5 - adminEmail
#
# The Admin Email is the field to set the administrator's
# email for a given server. It is also used for
# replies to the email messages sent by the system.
#
# REQUIRED
#############################################################
################
adminEmail=admin@example.com

#############################################################
################
# 6- Spring Based Email System
#
# Configure the Email SMTP host below. If the host
# requires a username and password make sure



# mail.smtp(s).auth is set to true.
# Configure mail protocol via mail.protocol, Valid options
# would be smtp or smtps.
# Configure smtp over ttls by setting mail.smtp(s).starttls.enable
# to true.
# Configure connection timeout. Preconfigred to 5 secs
#############################################################
################
mailHost=mail.smtp.com
mailPort=25
mailProtocol=smtp
mailUsername=
mailPassword=
mailSmtpAuth=false
mailSmtpStarttls.enable=false
mailSmtpsAuth=false
mailSmtpsStarttls.enable=false
mailSmtpConnectionTimeout=100
mailErrorMsg=developers@openclinica.org

#############################################################
#################
#
#        This property will be removed starting from 3.1.3

#
# 7 - passwd_expiration
#
# Passwd Expiration Time is the number of
# days that can elapse before a user is notified that
# they should change their password.
#
# REQUIRED.
#############################################################
################
passwdExpirationTime=360

#############################################################
################
# 8 - sysURL
#
# The web address for the system.  It can either be an external
# address (demo.openclinica.org) or an internal IP
# address (192.168.2.000).
# NOTE: If you reconfigure the address or port in some later
# step, such as by configuring SSL, you will need to come back
# and update this file. You will also need to restart tomcat
# for changes to this take effect.
#
# REQUIRED
#############################################################



################
sysURL=http://192.168.2.000:8080/${WEBAPP}/MainMenu

#############################################################
################
# 9 - max_inactive_interval
#
# This is maximum time interval between client requests. That is,
# if users leave any page open without sending a request to the
# server, after this time interval, when users attempt sending
# request they will be directed to login page.
#
# REQUIRED
#############################################################
################
maxInactiveInterval=3600

#############################################################
################
#
#        This property will be removed starting from 3.1.3

# 10- change_passwd_required
# Change Passwd Required is a flag which will force users to change
# their password when they log on for the first time or when their
# time expires. 1 is for required, 0 is for not required.
#
# REQUIRED.
#############################################################
################
change_passwd_required=1

#############################################################
################
# 11 - Logging configuration

# SysLog support has been fully implemented in OpenClinica, but by default has been turned off.
# Every piece of code that could send information to the syslog server has not been reviewed
# and cleaned to ensure it is entirely readable and useful.  This will be an ongoing effort
# and resolved in a future release.  Please use the SysLog support at your own risk.
#
# Specify the log location - local/syslog/both
#
log.dir=${catalina.home}/logs/openclinica
logLocation = local
#
# Specify logging level - trace/debug/info/warn/error
logLevel = info
syslog.host = localhost
syslog.port = 514



#############################################################
################
# 12- News/About
# On the OpenClinica login screen, there will be a box to the right of the login section
# which can contain an RSS feed.  You can configure what RSS feed is used in the rss.rl field.
# If you do not want the RSS feed, please comment out rss.url and rss.more and uncomment
# about.text1 and about.text2.  These two fields can be used for any free form text that you
# you want to appear on the OpenClinica login page.
# the default feed is http://clinicalresearch.wordpress.com/feed/
# default value for rss.more http://clinicalresearch.wordpress.com/
#############################################################
################
# rssUrl=http://clinicalresearch.wordpress.com/feed/
# rssMore=http://clinicalresearch.wordpress.com/
# about.text1= Hello World 1
# about.text2= Hello World 2

#############################################################
################
# 13 - CRF File Upload Configuration
# crf.file.extensionSettings can have 3 values valid,invalid or left empty which defaults to valid.
# if crf.file.extensionSetting= valid , then extensions specified can be uploaded.
# if crf.file.extensionSetting= invalid , then extensions specified can NOT be uploaded.
# if crf.file.extensions is left empty and crf.file.extensionSettings=valid then all extensions are valid
# if crf.file.extensions is left empty and crf.file.extensionSettings=invalid then all extensions are
NOT valid  
# separate extensions with a comma and do not include the leading dot.
#############################################################
################
# crfFileExtensions=
# crfFileExtensionSettings=

#############################################################
################
# 14 - supportURL
#
# The Support URL is included in the support button that appears
# in the top right corner of all pages in OPenClinica. By including
# the URL here we will be able to configure it depending on the adopter
#
# REQUIRED
#############################################################
################
# supportURL=https://www.openclinica.com/OpenClinica/3.1/support/

#############################################################
################
# 15- Quartz Scheduler Configuration
#
# Configure the mis-fire threshold for the scheduler,
# and the number of extract jobs can run at a single time.



#
# REQUIRED
#############################################################
################
org.quartz.jobStore.misfireThreshold=18000000
org.quartz.threadPool.threadCount=1
org.quartz.threadPool.threadPriority=5

#############################################################
################
# 16 - CCTS configuration
#
# This is used for OpenClinica instances that have been modified and configured
# to work with the Cancer Clinical Trials Suites.  This is a caBIG suite of applications.
# The configuration determines how long OpenClinica will hold a transaction from C3PR
# and will wait for a roll back message before committing it to the database.
#
# NOT REQUIRED
#############################################################
################
ccts.waitBeforeCommit=6000

#############################################################
################
# 17 - Facility information
#
# The OpenClinica defaults will be used when creating a new study
# unless you uncomment each property and provide a value next to
# each = sign.
#
# NOT REQUIRED
#############################################################
################
# FacName=
# FacCity=
# FacState=
# FacZIP=
# FacCountry=
# FacContactName=
# FacContactDegree=
# FacContactPhone=
# FacContactEmail=

#############################################################
################
# 18 - export data file path
#
# Export Data File Path is the string which (optionally)
# declares a specific file path for file extracts to be
# saved.  This is a sub folder of filePath.
# Note that if it is set, files from Jobs only will be saved



# to two places: this directory and under the above file path
# declared in the 'filePath' property.
#
# NOT REQUIRED.  Please comment out if you want Jobs to generate
# one file/files only, in the directory structure under 'filePath'.
#############################################################
################
# exportFilePath=scheduled_data_export
#############################################################
################
# 19 - Usage statistics configuration
# Usage statistics refers to information automatically sent back to OpenClinica.org
# to help us figure out how well OpenClinica is working and help us improve it in
# future versions.
# This includes technical information such as the version of OpenClinica installed, the number of
studies created and user load. These statistics DO NOT include information such as study or CRF
names, study data, or user information. We collect this data in aggregate and use it according to our
Privacy Policy [https://community.openclinica.com/privacy-policy] to improve our products and
services.
#
# As part of system configuration, we give you the option to help us improve OpenClinica by sending
these usage statistics. If you elect to send this information but later change your mind, you can
disable this feature in the datainfo.properties file by changing
# 'collectStats' value to 'false'
collectStats=true
usage.stats.host=usage.openclinica.com
usage.stats.port=514
OpenClinica_version=${version}

#############################################################
################
# 20 - Rule Designer configuration
# OpenClinica Enterprise customers are allowed access to a GUI based Rule Designer.  
# This configuration allows the OpenClinica instance to contact the Rule Designer for
# access.  If you are not an OpenClinica Enterprise customer, your users will be re-directed
# to a landing page and will have to navigate back to their OpenClinica instance.
# If you do not want to see a link to the Rule Designer on the Build Study page,
# you must delete this configuration option.
#
# To become an OpenClinica Enterprise customer, please contact sales@openclinica.com
#############################################################
################

designerURL=https://designer.openclinica.com/

10.12.15 Description of datainfo.properties
File for Web Services
Web Services datainfo.prioperties file is similar the datainfo.properties of OpencClinica. However,



web services needs less configuration than OpenClinica. The following file show highlighted
properties that are relevant to web services. Only properties from first section must be updated and
should be set exaclty as they are set for OpenClinica.

 

#############################################################
################

# 1 - Database Configuration
#
# Database configuration is done with the following 6 properties
# The dbType options are either postgres or oracle.
# Enter the user name and password to access the database in 
# dbUser and dbPass.
# The db field is for the name of the database and provide the port
# in dbPort.
# dbHost can be a URL, IP address or localhost
#
# REQUIRED
#############################################################
################
dbType=postgres
dbUser=clinica
dbPass=clinica
db=openclinica
dbPort=5432
dbHost=localhost

#############################################################
################
# 2 - filePath
#
# File Path is the string which declares the
# repository for all uploaded and generated
# files in the system, including CRFs and
# data sets.  The directory should NOT be
# accessible by the web server.
#
# REQUIRED.  
#############################################################
################
filePath=${catalina.home}/${WEBAPP.lower}.data/

#############################################################
################
# 3 - Attached File Location
# Location for files if item data type is "file". If it has been kept empty,
# "filePath" will be used as the attached file location.
# This will be a sub folder within the filePath location only.
# You may configure a full path that points to a directory outside of the filePath.



# If you configure a full path, it must have a trailing slash.
# Example = /usr/local/attached_file/ or C:\attached_file\
#
# NOT REQUIRED
#############################################################
################
# attached_file_location=

#############################################################
################
# 4 - user_account_notification
#
# User Account Notification is the method by
# which new users are sent their passwords.
# Users can be sent passwords via email,
# or the password can be displayed on the screen
# to the administrator, who is instructed to
# write it down and physically give it to the user
# in question.  The default is email.
#
# REQUIRED.  
#############################################################
################
userAccountNotification=email

#############################################################
################
# 5 - adminEmail 
#
# The Admin Email is the field to set the administrator's
# email for a given server. It is also used for
# replies to the email messages sent by the system.
#
# REQUIRED
#############################################################
################
adminEmail=admin@example.com

#############################################################
################
# 6- Spring Based Email System
#
# Configure the Email SMTP host below. If the host
# requires a username and password make sure
# mail.smtp(s).auth is set to true.
# Configure mail protocol via mail.protocol, Valid options 
# would be smtp or smtps.
# Configure smtp over ttls by setting mail.smtp(s).starttls.enable
# to true.
# Configure connection timeout. Preconfigred to 5 secs
#############################################################



################
mailHost=mail.smtp.com
mailPort=25
mailProtocol=smtp
mailUsername=
mailPassword=
mailSmtpAuth=false
mailSmtpStarttls.enable=false
mailSmtpsAuth=false
mailSmtpsStarttls.enable=false
mailSmtpConnectionTimeout=100
mailErrorMsg=developers@openclinica.org

#############################################################
################
# 8 - sysURL
#
# The web address for the system.  It can either be an external
# address (demo.openclinica.org) or an internal IP
# address (192.168.2.000).
# NOTE: If you reconfigure the address or port in some later
# step, such as by configuring SSL, you will need to come back
# and update this file. You will also need to restart tomcat
# for changes to this take effect.
#
# REQUIRED
#############################################################
################
sysURL=http://localhost:8080/${WEBAPP}/MainMenu

#############################################################
################
# 9 - max_inactive_interval
#
# This is maximum time interval between client requests. That is,
# if users leave any page open without sending a request to the 
# server, after this time interval, when users attempt sending 
# request they will be directed to login page.
#
# REQUIRED
#############################################################
################
maxInactiveInterval=3600

#############################################################
################
# 11 - Logging configuration

# SysLog support has been fully implemented in OpenClinica, but by default has been
turned off.
# Every piece of code that could send information to the syslog server has not been



reviewed 
# and cleaned to ensure it is entirely readable and useful.  This will be an ongoing effort 
# and resolved in a future release.  Please use the SysLog support at your own risk.
#
# Specify the log location - local/syslog/both
#
log.dir=${catalina.home}/logs/openclinica-ws
logLocation = local
#
# Specify logging level - trace/debug/info/warn/error
logLevel = info
syslog.host = localhost
syslog.port = 514

#############################################################
################
# 12- News/About
# On the OpenClinica login screen, there will be a box to the right of the login section
# which can contain an RSS feed.  You can configure what RSS feed is used in the rss.rl field.
# If you do not want the RSS feed, please comment out rss.url and rss.more and uncomment
# about.text1 and about.text2.  These two fields can be used for any free form text that you
# you want to appear on the OpenClinica login page.
# the default feed is http://clinicalresearch.wordpress.com/feed/
# default value for rss.more http://clinicalresearch.wordpress.com/
#############################################################
################
# rssUrl=http://clinicalresearch.wordpress.com/feed/
# rssMore=http://clinicalresearch.wordpress.com/
# about.text1= Hello World 1
# about.text2= Hello World 2

#############################################################
################
# 13 - CRF File Upload Configuration
# crf.file.extensionSettings can have 3 values valid,invalid or left empty which defaults to valid.
# if crf.file.extensionSetting= valid , then extensions specified can be uploaded.
# if crf.file.extensionSetting= invalid , then extensions specified can NOT be uploaded.
# if crf.file.extensions is left empty and crf.file.extensionSettings=valid then all extensions are valid
# if crf.file.extensions is left empty and crf.file.extensionSettings=invalid then all extensions are
NOT valid  
# separate extensions with a comma and do not include the leading dot.
#############################################################
################
# crfFileExtensions=
# crfFileExtensionSettings=

#############################################################
################
# 14 - supportURL
#
# The Support URL is included in the support button that appears



# in the top right corner of all pages in OPenClinica. By including
# the URL here we will be able to configure it depending on the adopter
# 
# REQUIRED 
#############################################################
################
# supportURL=https://www.openclinica.com/OpenClinica/3.1/support/ 

#############################################################
################
# 15- Quartz Scheduler Configuration
#
# Configure the mis-fire threshold for the scheduler, 
# and the number of extract jobs can run at a single time.
#
# REQUIRED
#############################################################
################
org.quartz.jobStore.misfireThreshold=18000000
org.quartz.threadPool.threadCount=1
org.quartz.threadPool.threadPriority=5

#############################################################
################
# 16 - CCTS configuration - for caBIG Web Services only
# 
# This is used for OpenClinica instances that have been modified and configured
# to work with the Cancer Clinical Trials Suites.  This is a caBIG suite of applications.
# The configuration determines how long OpenClinica will hold a transaction from C3PR
# and will wait for a roll back message before committing it to the database.
#
# NOT REQUIRED
#############################################################
################
ccts.waitBeforeCommit=6000

#############################################################
################
# 17 - Facility information
#
# The OpenClinica defaults will be used when creating a new study
# unless you uncomment each property and provide a value next to 
# each = sign.
#
# NOT REQUIRED
#############################################################
################
# FacName=
# FacCity=
# FacState=
# FacZIP=



# FacCountry=
# FacContactName=
# FacContactDegree=
# FacContactPhone=
# FacContactEmail=

#############################################################
################
# 18 - export data file path
#
# Export Data File Path is the string which (optionally) 
# declares a specific file path for file extracts to be
# saved.  This is a sub folder of filePath.
# Note that if it is set, files from Jobs only will be saved 
# to two places: this directory and under the above file path
# declared in the 'filePath' property.
#
# NOT REQUIRED.  Please comment out if you want Jobs to generate
# one file/files only, in the directory structure under 'filePath'.
#############################################################
################
# exportFilePath=scheduled_data_export

#############################################################
################
# 19 - Usage statistics configuration
# Usage statistics refers to information automatically sent back to OpenClinica.org
# to help us figure out how well OpenClinica is working and help us improve it in 
# future versions.
# This includes technical information such as the version of OpenClinica installed, the number of
studies created and user load. These statistics DO NOT include information such as study or CRF
names, study data, or user information. We collect this data in aggregate and use it according to our
Privacy Policy [https://community.openclinica.com/privacy-policy] to improve our products and
services.
#
# As part of system configuration, we give you the option to help us improve OpenClinica by sending
these usage statistics. If you elect to send this information but later change your mind, you can
disable this feature in the datainfo.properties file by changing 
# 'collectStats' value to 'false'
collectStats=true
usage.stats.host=usage.openclinica.com
usage.stats.port=514
OpenClinica_version=${version}

#############################################################
################
# 20 - Rule Designer configuration
# OpenClinica Enterprise customers are allowed access to a GUI based Rule Designer.  
# This configuration allows the OpenClinica instance to contact the Rule Designer for 
# access.  If you are not an OpenClinica Enterprise customer, your users will be re-directed
# to a landing page and will have to navigate back to their OpenClinica instance.



# If you do not want to see a link to the Rule Designer on the Build Study page, 
# you must delete this configuration option.
# 
# To become an OpenClinica Enterprise customer, please contact sales@openclinica.com
#############################################################
################

designerURL=https://designer.openclinica.com/

10.12.16 Verify Access to OpenClinica
At this point, Java, Tomcat, PostgreSQL, and OpenClinica are installed and set up. Restart the
system by running:

reboot

After the system starts up, access OpenClinica at the following URL:

http://localhost:8080/OpenClinica

The Log In page should display.

To verify your set-up, try to access OpenClinica from another computer by running the same
command from that computer, but replace localhost with the server's IP or hostname.

10.12.17 Verify Access to OpenClinica Web
Services
At this point, Java, Tomcat, PostgreSQL, and OpenClinica and OpenClinica Web Services are
installed and set up. Restart the system by running:

reboot

After the system starts up, access OpenClinica Web Services at the following URL:

http://localhost:8080/OpenClinica-ws

The Welcome page should display.

To verify your set-up, try to access OpenClinica Web Services from another computer by running the
same command from that computer, but replace localhost with the server's IP or hostname.

10.12.18 Configure Tomcat to Use HTTPS
OpenClinica strongly recommends securing the Tomcat application server using a Secure Socket
Layer protocol (SSL). SSL is a data transport encryption technology used to make secure https://
connections. SSL requires a third-party security certificate to be effective. Information about
configuring SSL certificates for Tomcat is at this website:
http://tomcat.apache.org/tomcat-6.0-doc/ssl-howto.html.

http://tomcat.apache.org/tomcat-6.0-doc/ssl-howto.html


10.12.19 Verify the Installation
Log in to OpenClinica with the username root and the password 12345678. OpenClinica requires you
to change the password for the user "root" to a secure password. See Update User Profile if you
need more information.

The user "root" is assigned to the Study "Default". Create a user account login for yourself, with the
User Type set to "technical administrator" and the User Role set to Data Manager. For instructions
to create the user account, see Create a New User.

10.13 Install OpenClinica 3.1.x on Windows
These installation instructions have been verified on the following Windows Operating Systems
versions:

Windows Server 2003 Standard Edition SP2
Windows Server 2003 Standard Edition SP1
Windows XP Professional Version 2002 SP2

These instructions are for installing version 3.1 of OpenClinica, and also apply to installing the
maintenance releases of 3.1 for example 3.1.2. When you see v.x or v.x.y in the instructions, use your
version number, e.g. 3.1.2.

Screenshots shown in these instructions might look different than the screens on your system
because your operating system might not be the same. The screenshots might not correspond
exactly with the written instructions. Where the screenshot differs from the written instruction,
always follow the written instruction.

All characters in the installation commands are case sensitive. Also note that any additional white
space between or after characters in commands could cause installation errors.

Approved for publication by Ben Baumann. Signed on 2014-03-28 4:02PM

Not valid unless obtained from the OpenClinica document management system on the day of
use.

10.13.1 Overview of Installation on Windows
Systems
Use the following process to acquire, install, and configure OpenClinca and its software
dependencies. In each step, click the link to view detailed instructions for that step:

Ensure your system complies with software dependencies and operating system requirements.1.
Install Java2.
Install the database you will use, PostgreSQL or Oracle:3.

Follow these instructions to install PostgreSQL.

https://docs.openclinica.com/3.1/openclinica-user-guide/working-openclinica#content-title-3603
https://docs.openclinica.com/3.1/administer-users#content-title-2979
https://docs.openclinica.com/3.1/installation/installing-openclinica-windows#content-title-3759
https://docs.openclinica.com/3.1/installation/installing-openclinica-windows#content-title-3761


If you are using Oracle, you will need to obtain the instructions to install it. OpenClinica
does not provide instructions to install Oracle.

Install Tomcat.4.
Install the OpenClinica package.5.
Set up the database you installed:6.

Set up PostgreSQL.
Configure Tomcat7.
Configure the OpenClinica application.8.
Start Tomcat.9.
Verify the installation.10.
Configure Tomcat to use HTTPS: Follow the same instructions as for Linux systems.11.

After completing the OpenClinica installation, see the Overview of OpenClinica for instructions to
start using the application. A good first step is to define one or more users (especially a Study
Director), and then build a Study.

10.13.2 Software Dependencies and
Operating System Requirements
Windows Configuration

Your Windows operating system must be configured to show file extensions by default. To configure
this behavior:

Open a Windows Explorer window.1.
Select Tools > Folder Options.2.
Click the View tab.3.
In Advanced settings, clear the Hide extensions for known file types checkbox.4.
Click Apply5.

Software Dependencies

OpenClinica runs on any Servlet/JSP container that implements the Servlet 2.4 and JavaServer Pages
2.0 specifications from the Java Community Process. OpenClinica was developed to run on and has
been tested with Apache Tomcat 6.0.32.

OpenClinica runs on either the PostgreSQL relational database or an Oracle relational database.
Using a
JDBC (Java Database Connectivity) driver, the database connects to the OpenClinica web application
and provides the data to the user.

New installations require the following software, which is all open source. These installation
instructions step you through the process of downloading, installing, and configuring it for use with
OpenClinica:

Java 6 Standard Edition Development Kit 6.0 update 24 (Note: Java frequently changes its
naming conventions.)
Tomcat 6.0.32
PostgreSQL 8.4.7.2 or Oracle 10g
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Other Versions of Dependent Software

The software dependencies OpenClinica uses are open source, and frequently updated with minor
versions and revisions. Sometimes only a matter of weeks separates the release of two adjacent
versions. At the time of this OpenClinica release, the latest stable version of Java, Tomcat, and
PostgreSQL were used in integrated testing (and are referenced in this document). In some cases,
the revision number used is no longer available. In general, you should be able to use more recent
minor versions and revisions of the software dependencies. For example, if the installation
instructions refer to PostgreSQL 8.4.7.2, then PostgreSQL 8.4.8 should work successfully too (but
not PostgreSQL 9).

Record the version or revision number of all the software you use. If you have concerns about a
particular combination, post your question to the users@openclinica.com mailing list.

10.13.3 Install Java
The OpenClinica software is written in the Java programming language, so you must have Java
installed on your system in order to run the OpenClinica application. Follow these instructions to
install Java:

OpenClinica 3.1 is designed to run on a Java 6 SDK 1.6.x platform. To avoid conflicts with1.
other versions of Java, clear out any other Java installations on the system. Select Start >
Control Panel > Add Remove Programs, then remove any Java JREs and SDKs.
Create the directory c:ocinstall.2.
From one of the following websites, download the Java 6 SE Development Kit 6.0 update 243.
(jdk-6u24-windows-i586.exe) into c:ocinstall:

Java:
http://www.oracle.com/technetwork/java/javasebusiness/downloads/java-archive-downloa
ds-javase6-419409.html#jdk-6u24-oth-JPR
OpenClinica: http://svn.akazaresearch.com/oc/software/OpenClinica-3.1/windows/

Run c:ocinstalljdk-6u24-windows-i586.exe.4.
The Open File - Security Warning message displays.
Click Run.5.
The Welcome to Java Installation Wizard opens.
Click Next.6.
The Custom Setup screen displays.
Click Change....7.
Change the path to c:ocjdk1.6.0_24, then click OK.8.
The Custom Setup screen should now look like this:

mailto:users@openclinica.com
http://www.oracle.com/technetwork/java/javasebusiness/downloads/java-archive-downloads-javase6-419409.html#jdk-6u24-oth-JPR
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Click Next.9.
The Setup Wizard installs the JDK. When setup completes, a screen to install JRE6 displays.
Click Cancel, and then in the confirmation dialog box click Yes.10.
The Install Success screen displays.
Click Finish.11.
A web browser window opens, presenting you with the option to register the JDK. Register, or12.
close the window.

10.13.4 Install PostgreSQL Database
The OpenClinica software uses an underlying relational database management system, either
PostgreSQL or Oracle. Complete these instructions if you will be using the PostgreSQL database. If
you will be using the Oracle database, install Oracle instead of completing these instructions. Note:
we do not provide instructions for installing Oracle.

From this location http://svn.akazaresearch.com/oc/software/OpenClinica-3.1/windows/,1.
download postgresql-8.4.7-2-windows.exe to c:ocinstall.
Run:2.
c:ocinstallpostgresql-8.4.7-2-windows.exe
The Open File Security Warning message displays.
Click Run.3.
The PostgreSQL Installation Wizard opens.
Click Next.4.
The Installation directory screen displays.
Click Next to accept the default values.5.
The Data directory screen displays.
Click Next to accept the default values.6.
The Password screen displays.
Enter a password for the Postgres superuser. Record the password for use later in the7.
installation process. Re-enter the password, and click Next.

http://svn.akazaresearch.com/oc/software/OpenClinica-3.1/windows/


The Port screen displays.
Click Next to accept the default value (5432).8.
The Advanced Options screen displays.

Complete the screen as follows:9.
For Locale, select "Default locale".1.
Clear the Install pl/pgsql in template1 database? checkbox.2.
Click Next.3.

The Ready to install screen displays
Click Next to start the installation.10.
When the installation finishes, the Completing the PostgreSQL Setup Wizard screen displays.
Clear the Launch Stackbuilder at exit checkbox, then click Finish.11.

10.13.5 Install Tomcat
From either of the following websites, download the Windows Service Installer Version,1.
apache-tomcat-6.0.32.exe, and save it to c:ocinstall:

Apache: http://tomcat.apache.org/download-60.cgi
OpenClnica: http://svn.akazaresearch.com/oc/software/OpenClinica-3.1/windows/

Run2.
c:ocinstallapache-tomcat-6.0.32.exe
The Apache Tomcat Setup Installation Wizard opens.
When the Open File - Security Warning message displays, click Run.3.
On the Welcome screen of the Apache Tomcat Setup Installation Wizard, click Next.4.
The License Agreement screen displays.
Click I Agree to accept the agreement.5.
The Choose Components screen displays.
Click Next to accept the default values.6.
The Configuration screen displays.
Click Next to accept the default values.7.

http://tomcat.apache.org/download-60.cgi
http://svn.akazaresearch.com/oc/software/OpenClinica-3.1/windows/


The Java Virtual Machine screen displays.
Click ..., then select the path you installed the JDK into:8.
c:ocjdk1.6.0_24
The screen now should look like this:

Click Next.9.
The Choose Install Location screen displays.
Edit the Destination Folder to be c:octomcat. The screen should look like this:10.



Click Install to start the installation.11.
When the installation is finished, the Completing the Apache Tomact Setup Wizard screen
displays.
Complete the screen as follows:12.

Clear the Run Apache Tomcat checkbox.1.
Clear the Show Readme checkbox.2.

The screen should now look like this:

Click Finish.13.
Create the directory c:octomcatoldwebapps.14.
Move the web apps provided with Tomcat that OpenClinica does not need by moving the15.
contents of c:octomcatwebapps to c:octomcatoldwebapps.

10.13.6 Install OpenClinica Package
Download the OpenClinica software, OpenClinica-v.x.y.zip, from the OpenClinica website1.
location, https://community.openclinica.com/project/openclinica. To download the software,
you need a community account, which is free to create; you will be required to log in to the
account to download the OpenClinica software.

After downloading the OpenClinica software, move it to the directory with the other software
dependencies you downloaded:
c:ocinstall.

Right-click OpenClinica-v.x.y.zip and select Extract All.2.
The Extraction Wizard opens.
Click Next.3.
In the next screen, change the directory to c:ocinstall, and click Next.4.
In the next screen, clear the Show Extracted Files checkbox, and click Finish.5.
Copy c:ocinstallOpenClinica-v.x.ydistributionOpenClinica.war to c:octomcatwebapps.6.

https://community.openclinica.com/project/openclinica
https://www.openclinica.com/cas/login?service=https://community.openclinica.com/cas?destination=https://www.openclinica.com/


10.13.7 Install OpenClinica Web Services
Package
Web Services are optional. Please do not install them if you are not planning on using web services.

Download the OpenClinica-ws software, OpenClinica-ws-v.x.y.zip, from the OpenClinica1.
website location, https://community.openclinica.com/project/openclinica. To download the
software, you need a community account, which is free to create; you will be required to log in
to the account to download the OpenClinica software. After downloading the OpenClinica-ws
software, move it to the directory with the other software dependencies you
downloaded: c:ocinstall.
Right-click OpenClinica-ws-v.x.y.zip and select Extract All.2.
The Extraction Wizard opens.3.
Click Next.4.
In the next screen, change the directory to c:ocinstall, and click Next.5.
In the next screen, clear the Show Extracted Files checkbox, and click Finish.6.
Copy c:ocinstallOpenClinica-ws-v.x.ydistributionOpenClinica-ws.war to c:octomcatwebapps.7.

10.13.8 Set Up the PostgreSQL Database
Complete these instructions if you will be using the PostgreSQL database. If you will be using the
Oracle database, instead use the Oracle setup instructions.

Select Start > Programs > PostgreSQL 8.4 > pgAdminIII.1.
The pgAdminIII window opens. Right-click the PostgreSQL 8.4 (localhost:5432) icon, and2.
select Connect, as shown here:

Log in to the database server using the password you set up during the PostgreSQL3.

https://community.openclinica.com/project/openclinica
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installation.
Create the database openclinica and the database user clinica, which OpenClinica uses to4.
connect to the database:

Expand the databases, and select postgreSQL.1.
Select Tools > Query tool.2.
The Query window opens.
In the SQL Editor box, delete all the text.3.
In the SQL Editor box, type the following:4.
CREATE ROLE clinica LOGIN ENCRYPTED PASSWORD 'clinica' SUPERUSER
NOINHERIT NOCREATEDB NOCREATEROLE;
Select Query > Execute, which runs the SQL query.5.
When the query completes, a message displays in the History window.
In the SQL Editor box, delete all the text.6.
In the SQL Editor box, type the following:7.
CREATE DATABASE openclinica WITH ENCODING='UTF8' OWNER=clinica;
Select Query > Execute.8.
When the query completes, a message displays in the History window.
Close the Query window, and click No when prompted to save changes.9.

The database password is set to clinica by default, which is not a secure password. Change the5.
password as follows:

In the pgAdminIII window, expand and select Login Roles.1.
Select View > Refresh.2.
The clinica database user is listed.
Right-click the clinica user account and select Properties.3.
In the Login Role for clinica box that displays, enter the new password and re-enter it,4.
then click OK. Record the password for future use.

10.13.9 Configure Tomcat
Select Start > Apache Tomcat 6.0 > Configure Tomcat.1.
The Apache Tomcat 6 Properties window opens.
Click the Java tab, then complete the Java page as follows:2.

For Maximum memory pool, enter 1280.1.
In the Java Options text box, add this line at the end:2.

-XX:MaxPermSize=180m

Please note that this setting is based upon the number of war files deployed. The web war needs a
180m of PermGen and the ws war needs a 90m of PermGen memory settings.

The window should now look like this:1.



Click Apply, which completes the configuration of Tomcat.2.
Start Tomcat:3.

Click the General tab.1.
On the General page, click Start.2.

In about five minutes, Tomcat will be fully started. Verify it is fully started by opening the file4.
c:octomcatlogscatalina.out, and looking for this line:
INFO: Server Startup in XXXXX ms
After verifying Tomcat has fully started, in the General page of the Apache Tomcat 65.
Properties window, click Stop.
Wait two minutes for Tomcat to stop, then delete OpenClinca.war from c:octomcatwebapps.6.

10.13.10 Configure OpenClinica for better
Performance
Under stress test, OpenClinica has performed well with the following JVM settings: 

Please click the Java Options tab described in the 'Configure Tomcat' section and add the following 

 -XX:+UseParallelGC
-XX:ParallelGCThreads=n
-XX:MaxPermSize=180m
-XX:+CMSClassUnloadingEnabled

 On Java Console use 'Maximum Pool Size' to 1280.

Please note that the bare minimum ram requirement is 1280 MB of memory for these settings, so
the CPU is expected to have much higher RAM available.

Where n is the number of cores of your CPU.  There should be no spaces before or after each entry,



Also each entry should be in a new line. The MaxPermSize value depends on the number of war files
that you are deploying. For instance, if you deploy web and web servics, XX:MaxPermSize should be
set to 360m. 

 -XX:ParallelGCThreads = # of cores of your CPU, as long as the number of processors on your CPU
are lesser than 8.   The Window should look like this for a 4 core processor:

After the above settings have been applied, start Tomcat

10.13.11 Configure the OpenClinica
Application
If you followed all the previous instructions exactly, there is only one property in the configuration
file, datainfo.properties, that you may need to change in order for OpenClinica to start. There are
other properties in the configuration file you will probably want to modify for your system, however.

Using WordPad, open the configuration file:1.
c:octomcatwebappsOpenClinicaWEB-INFclassesdatainfo.properties
Edit values for the properties in the datainfo.properties file. You must change the value for2.
dbPass to the password you selected in Set Up the PostgreSQL Database. Change the values
for any other properties.

The datainfo.properties file for Windows is the same as for Linuxsee more information at
Description of datainfo.properties File.
When you finish making changes, save the file.3.
You may also need to configure OpenClinica for internationalization should you wish to utilize4.
OpenClinica in different languages. Also, if you need to use some UTF-8 characters in your
application, you may need to modify your default connecter configuration. For more
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information regarding configuring OpenClinica for internationalization and using UTF-8
characters, please refer
to https://docs.openclinica.com/3.1/technical-documents/openclinica-and-internationalization

10.13.12 Configure the OpenClinica Web
Services
If you followed all the previous instructions exactly, there is only one property in the configuration
file, datainfo.properties, that you may need to change in order for OpenClinica Web Services to
start. There are other properties in the configuration file you will probably want to modify for your
system, however.

Note: Most of the properties are not needed or used for Web Services, see Description of
datainfo.properties File for Web Services for more information on what settings are actually used.

Using WordPad, open the configuration file:1.
c:octomcatwebappsOpenClinica-wsWEB-INFclassesdatainfo.properties
Edit values for the properties in the datainfo.properties file. You must change all values from2.
Database Configuration section of datainfo.properties file to reflect your settings in
datainfo.properties file for OpenClinica application. Change the values for any other
properties. 

The datainfo.properties file for Windows is the same as for Linuxsee more information
at Description of datainfo.properties File for WebServices.
If you are installing Web Services for OpenClinica 3.1.2 and early please edit adminEmail3.
property (section 5 - adminEmail) if you would like e-mail to be send through 'Contact' link
from Web Services welcome page.
Other properties that can be configured for web services are:4.

Section 11 - Logging configuration1.
When you finish making changes, save the file.5.

10.13.13 Start Tomcat
Start Tomcat using any one of these methods:

From the Apache Tomcat 6 Properties window:
Select Start > Apache Tomcat 6.0 > Configure Tomcat to open the window.1.
Click the General tab.2.
On the General page, click the Start button to start Tomcat.3.

Using the Windows run command:
Select Start > Run.1.
In the Run box, type cmd, then click OK.2.
At the new command prompt, start Tomcat by typing3.
net start tomcat6
then press Enter.

When you need to stop Tomcat, type
net stop tomcat6
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then press Enter.

Via the Windows Services Microsoft Management Console (MMC), if you are familiar with it.

10.13.14 Verify the Installation
At this point, Java, Tomcat, PostgreSQL, and OpenClinica are installed and set up. Verify the
installation was successful by following these steps:

Open a web browser and access OpenClinica at the following URL:1.

http://localhost:8080/OpenClinica

The OpenClinica Log In page should display.

Log in to OpenClinica using the default user name, root, and password 12345678. You will be2.
forced to change the password for the user "root" to a secure password. See Update User
Profile if you need more information.

The user "root" is assigned to a default Study named "Default." Create a user account for3.
youself, with the User Type set to "technical administrator" and the User Role set to Data
Manager: for instructions to create the user account, see Create a New User.

 

10.13.15 Verify the Installation of
OpenClinica Web Services

Point your web browser to the OpenClinica Web Services welcome page: http://<<server1.
url>>:8080/OpenClinica-ws. The OpenClinica Web Services Welcome page should be display.
Verify the version number is v.x.x-Community, where v.x.x is the version number you upgraded2.
OpenClinica Web Services to. The version number is displayed in the lower right corner of the
page.

Web Services should have the same version as OpenClinica application.

10.14 Upgrade to OpenClinica 3.1.x on Linux
These instructions are for upgrading from OpenClinica 3.0.x to version 3.1 or to a 3.1.x maintenance
release on Linux systems running the essential software dependencies: Java 6, Tomact 6, and
PostgreSQL 8.4. When you see v.x or v.x.x or similar in the instructions, use the version number you
are upgrading to, e.g. 3.1 or 3.1.2.

The instructions apply only if you followed the upgrade instructions to get to 3.0.x; if you did not,
you might need to do other things in order to upgrade your system. 

If you are running an earlier version of OpenClinica and/or its related software dependencies, make
sure you upgrade these to the required versions before upgrading beyond OpenClinica 3.0.x. Please
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note that these instructions do not cover upgrading related software dependencies for 3.1.x. To
upgrade these components, you'll need to follow the instructions provided by those technologies.
Make sure you back up everything so your existing files are not lost.

If you are upgrading from OpenClinica 2.5.x, you need to first upgrade to 3.0.x, and you will need to
upgrade the software dependencies so they meets the requirements for OpenClinica 3.0.x. Perform a
full backup of your 2.5.x instance, perform a fresh install of 3.0.x, and then restore your 2.5.x data.
For information about backing up your 2.5.x instance, see the 3.0.x upgrade documentation that is
included with the downloaded files for 3.0.x.

Approved for publication by Ben Baumann. Signed on 2014-03-25 11:07AM

Not valid unless obtained from the OpenClinica document management system on the day of
use.

10.14.1 Overview of the Upgrade Process on
Linux Systems
Follow this process to upgrade OpenClinica. In each step, click the link to view detailed instructions
for the step:

Back up OpenClinica.1.
Upgrade OpenClinica.2.
Configure OpenClinica:3.

Make any changes needed to the datainfo.properties file as described here: Configure1.
the OpenClinica Application.
Ensure that OpenClinica is configured for optimum performance as described here:2.
Configure OpenClinica for Optimum Performance.
You may also need to configure OpenClinica for internationalization should you wish to3.
utilize OpenClinica in different languages. Also, if you need to use some UTF-8
characters in your application, you may need to modify your default connecter
configuration. For more information regarding configuring OpenClinica for
internationalization and using UTF-8 characters, please refer
to https://docs.openclinica.com/3.1/technical-documents/openclinica-and-internationaliza
tion
Reboot the system by typing reboot.4.

Make manual updates to the database.4.
Start Tomcat by running the following command:5.
/etc/init.d/tomcat start

10.14.2 Overview of the Upgrade Process for
Web Services on Linux Systems
Follow this process to upgrade OpenClinica. In each step, click the link to view detailed instructions
for the step:

https://docs.openclinica.com/3-1/openclinica-user-guide/openclinica-user-guide-view-dataset/#content-title-5261
https://docs.openclinica.com/3-1/openclinica-user-guide/openclinica-user-guide-view-dataset/#content-title-5261
https://docs.openclinica.com/3-1/openclinica-user-guide/openclinica-user-guide-view-dataset/#content-title-5460
https://docs.openclinica.com/3.1/technical-documents/openclinica-and-internationalization
https://docs.openclinica.com/3.1/technical-documents/openclinica-and-internationalization


Upgrade OpenClinica Web Services.1.
Configure OpenClinica:2.

Make any changes needed to the datainfo.properties file as described here: Configure1.
the OpenClinica Application.
Ensure that OpenClinica is configured for optimum performance as described2.
here: Configure OpenClinica for Optimum Performance.
Reboot the system by typing reboot.3.

Start Tomcat by running the following command:3.
/etc/init.d/tomcat start4.

 

10.14.3 Back Up OpenClinica
Before upgrading, follow this process to back up the database and files needed by OpenClinica:

Stop Tomcat by running the following command:1.
/etc/init.d/tomcat stop
Confirm Tomcat has stopped before continuing.2.
Create the backup directory by running the following command:3.
mkdir -p /usr/local/oc/backup/manual/`date +%b-%d-%Y`
Make the backup directory become the current directory by running the following command:4.
cd /usr/local/oc/backup/manual/`date +%b-%d-%Y`
Run:5.
/opt/PostgreSQL/8.4/bin/pg_dump -F c -U postgres openclinica > openclinica.backup
When prompted for a password, enter the PostgreSQL database superuser password you6.
specified when setting up the database as part of installing OpenClinica.
Copy the files OpenClinica needs by running the following command:7.
cp -rf /usr/local/tomcat/openclinica* .
cp -rf /usr/local/tomcat/webapps/OpenClinica* .

10.14.4 Upgrade OpenClinica
Download the OpenClinica software from the OpenClinica website, using this location:1.
https://community.openclinica.com/project/openclinica. To download the software, use your
free community account; you will be required to log in to the account to download the
OpenClinica software. If you do not have an account, you may get one here.

After downloading the OpenClinica software, move it to:

/usr/local/oc/install
Run the following commands:2.
cd /usr/local/oc/install
unzip OpenClinica-v.x.y*
cd OpenClinica-v.x.y*/distribution
unzip OpenClinica.war -d OpenClinica
rm -rf /usr/local/tomcat/work/Catalina/localhost/OpenClinica*
rm -rf /usr/local/tomcat/webapps/OpenClinica*
cp -rf OpenClinica* /usr/local/tomcat/webapps
rm -f /usr/local/tomcat/webapps/OpenClinica.war

https://docs.openclinica.com/3.1/installation/install-3-1-x-linux#content-title-4342
https://docs.openclinica.com/3.1/installation/install-3-1-x-linux#content-title-4342
https://docs.openclinica.com/3-1/installation/3-1-installation-install-3-1-x-linux/#content-8387
https://docs.openclinica.com/3-1/installation/3-1-installation-install-3-1-x-linux/3-1-installation-installation-linux-postgres-db-setup/
https://community.openclinica.com/project/openclinica
https://www.openclinica.com/cas/login?service=https://community.openclinica.com/cas?destination=https://www.openclinica.com/
https://www.openclinica.com/cas/login?service=https://community.openclinica.com/cas?destination=https://www.openclinica.com/


10.14.5 Upgrade OpenClinica Web Services
Run upgrade for OpenClinica Web Services only if you are currently using Web Services 

Download the OpenClinica Web Services package from the OpenClinica website, using this1.
location: https://community.openclinica.com/project/openclinica. To download the software,
use your free community account; you will be required to log in to the account to download the
OpenClinica software. If you do not have an account, you may get one here.

After downloading the OpenClinica Web Services, move it to:

/usr/local/oc/install
Run the following commands:2.
cd /usr/local/oc/install
unzip OpenClinica-ws-v.x.y*
cd OpenClinica-ws-v.x.y*/distribution
unzip OpenClinica-ws.war -d OpenClinica-ws
rm -rf /usr/local/tomcat/work/Catalina/localhost/OpenClinica-ws*
rm -rf /usr/local/tomcat/webapps/OpenClinica-ws*
cp -rf OpenClinica-ws* /usr/local/tomcat/webapps
rm -f /usr/local/tomcat/webapps/OpenClinica-ws.war

10.14.6 Manual Database Updates
Now, you'll need to make database updates for your database: either PostgreSQL or Oracle. The
instructions apply to upgrading OpenClinica on Linux and Windows systems:

PostgreSQL

Open the file README_Instructions_for_Duplicate_Row_Fix.txt, located at1.
/usr/local/oc/OpenClinica-v.x.y/config/databases/v.x/PostgreSQL
Follow the instructions in the README file.2.

Oracle

At the location /usr/local/oc/OpenClinica-v.x.y/config/databases/v.x.y/Oracle/upgrade, open the1.
file README_Instructions_for_Duplicate_Row_Fix.txt, and follow the instructions in the
README file.
As the sysdba user, run the Grant_View.sql script located in /usr/local/oc/OpenClinica-2.
v.x.y/config/databases/v.x.y/Oracle/upgrade.
The script prompts you for a user name: provide the user name for the database user3.
OpenClinica is set up to use, as specified in the datainfo.properties file that you configured
during installation. Run this script before starting Tomcat. There is no risk in running this
script on a database that has already been upgraded to 3.1.y.

10.14.7 Verify the Upgrade
Test the database connection and basic authentication:1.

Point your web browser to1.

https://community.openclinica.com/project/openclinica
https://www.openclinica.com/cas/login?service=https://community.openclinica.com/cas?destination=https://www.openclinica.com/
https://www.openclinica.com/cas/login?service=https://community.openclinica.com/cas?destination=https://www.openclinica.com/


http://<<server url>>:8080
Verify that Tomcat is running. If the URL loads Tomact is running.2.
Point your web browser to the OpenClinica login page:3.
http://<<server url>>:8080/OpenClinica
The OpenClinica Log In page should display.
Log in to OpenClinica.4.

Verify the version number is v.x.x-Community, where v.x.x is the version number you upgraded2.
OpenClinica to. The version number is displayed in the lower right corner of the page.

10.14.8 Verify the Upgrade for OpenClinica
Web Services

Point your web browser to the OpenClinica Web Services welcome page: http://<<server1.
url>>:8080/OpenClinica-ws. The OpenClinica Web Services Welcome page should be display.
Verify the version number is v.x.x-Community, where v.x.x is the version number you upgraded2.
OpenClinica Web Services to. The version number is displayed in the lower right corner of the
page.

Web Services should have the same version as OpenClinica application.

10.15 Upgrade to OpenClinica 3.1.x on
Windows
These instructions are for upgrading from OpenClinica 3.0.x to version 3.1 , 3.1.x maintenance
release or to a 3.2 on Windows systems running the essential software dependencies: Java 6, Tomact
6, and PostgreSQL 8.4. When you see v.x or v.x.x or similar in the instructions, use the version
number you are upgrading to, e.g. 3.1 or 3.1.2.

The instructions apply only if you followed the upgrade instructions to get to 3.0.x; if you did not,
you might need to do other things in order to upgrade your system. 

If you are running an earlier version of OpenClinica and/or its related software dependencies, make
sure you upgrade these to the required versions before upgrading beyond OpenClinica 3.0.x. Please
note that these instructions do not cover upgrading related software dependencies for 3.1.x. To
upgrade these components, you'll need to follow the instructions provided by those technologies.
Make sure you back up everything so your existing files are not lost.

If you are upgrading from OpenClnica 2.5.x, you need to first upgrade to 3.0.x, and you will need to
upgrade the software dependencies so they meets the requirements for OpenClinica 3.0.x. Perform a
full backup of your 2.5.x instance, perform a fresh install of 3.0.x, and then restore your 2.5.x data.
For information about backing up your 2.5.x instance, see the 3.0.x upgrade documentation that is
included with the downloaded files for 3.0.x.

Approved for publication by Ben Baumann. Signed on 2014-03-28 4:04PM

Not valid unless obtained from the OpenClinica document management system on the day of
use.



10.15.1 Overview of the Upgrade Process on
Windows Systems

Ensure your system complies with software dependencies and system requirements.1.
Back up OpenClinica.2.
Upgrade OpenClinica.3.
Configure OpenClinica:4.

Ensure that OpenClinica is configured for optimum performance as described here:1.
Configure OpenClinica for Optimum Performance.
You may also need to configure OpenClinica for internationalization should you wish to2.
utilize OpenClinica in different languages. Also, if you need to use some UTF-8
characters in your application, you may need to modify your default connecter
configuration. For more information regarding configuring OpenClinica for
internationalization and using UTF-8 characters, please refer
to https://docs.openclinica.com/3.1/technical-documents/openclinica-and-internationaliza
tion

Verify the upgrade.5.
Make manual updates to the database. The instructions are the same as for upgrading6.
OpenClinica on Linux systems, except the README file on Windows systems is located at:
c:ocinstallOpenClinica-v.x.yconfigdatabasesPostgreSQL

10.15.2 Software Dependencies and System
Requirements
To upgrade to OpenClinica 3.1.x, you need the following:

Operating system must be either of these:
Windows XP
Windows Server 2003

Browsers supported in this release:
Internet Explorer 11
Mozilla Firefox 30

Software versions must be:
Java JDK 1.7.065
PostgreSQL 8.4.1
Tomcat 7.0.33.0 application server
Note: In most cases, minor maintenance releases of the above products will also work
(but not major releases)

10.15.3 Back Up OpenClinica
Before upgrading, follow this process to back up the database and files needed by OpenClinica:

Stop Tomcat. (See instructions, which are included in Start Tomcat.)1.
Back up the database (instructions here).2.
Back up the file3.
CATALINA_HOMEwebappsOpenClinicaWEB-INFclassesdatainfo.properties

https://docs.openclinica.com/3-1/installation/3-1-installation-installing-openclinica-windows/#content-8627
https://docs.openclinica.com/3.1/technical-documents/openclinica-and-internationalization
https://docs.openclinica.com/3.1/technical-documents/openclinica-and-internationalization
https://docs.openclinica.com/3.1/installation/installing-openclinica-windows#content-title-5383
https://docs.openclinica.com/3.1/technical-documents/system-administration/backup-and-restore-openclinica


Back up the folder4.
CATALINA_HOMEwebappsOpenClinica
Back up the CRFs and datasets, which are located in5.
CATALINA_HOMEwebappsopenclinica.data

10.15.4 Manual Database Updates
Now, you'll need to make database updates for your database: either PostgreSQL or Oracle. The
instructions apply to upgrading OpenClinica on Linux and Windows systems:

PostgreSQL

Open the file README_Instructions_for_Duplicate_Row_Fix.txt, located at1.
c:ocinstallOpenClinica-v.x.xconfigdatabasesPostgreSQL
Follow the instructions in the README file.2.

Oracle

At the location c:ocinstallOpenClinica-v.x.xconfigdatabasesOracleupgrade, open the file1.
README_Instructions_for_Duplicate_Row_Fix.txt, and follow the instructions in the README
file.
As the sysdba user, run the Grant_View.sql script located in c:ocinstallOpenClinica-2.
v.x.xconfigdatabasesOracleupgrade
The script prompts you for a user name: provide the user name for the database user3.
OpenClinica is set up to use, as specified in the datainfo.properties file that you configured
during installation. Run this script before starting Tomcat. There is no risk in running this
script on a database that has already been upgraded to 3.1.x.

10.15.5 Verify the Upgrade
Test the database connection and basic authentication:1.

Verify that Tomcat is running. If the URL loads Tomcat is running.1.
Point your web browser to the OpenClinica login page:2.
http://<<server url>>:8080/OpenClinica
The OpenClinica Log In page should display.
Log in to OpenClinica.3.

Verify the version number is v.x.x-Community, where v.x.x is the version number you upgraded2.
OpenClinica to. The version number is displayed in the lower right corner of the page.

10.15.6 Upgrade OpenClinica
Undeploy OpenClinica:1.

Delete the directory1.
CATALINA_HOMEwebappsOpenClinica
Delete the file2.
CATALINA_HOMEwebappsOpenClinica.war if exists
Delete the directory3.
workCatalinalocalhostOpenClinica

Create the following directory, if it does not already exist:2.



c:ocinstall
Download the OpenClinica software, OpenClinica-v.x.x.zip, from the OpenClinica website: 3.
https://community.openclinica.com/project/openclinica. To download the software, use your
free community account; you will be required to log in to the account to download the
OpenClinica software. If you do not have an account, you may get one here.

After downloading the OpenClinica software, extract the files to:
c:ocinstall.
Copy the file4.
c:ocinstallOpenClinica-v.x.xdistributionOpenClinica.war
to
c:octomcatwebapps
Start Tomcat. (See instructions at Start Tomcat.)5.
In about five minutes, Tomcat will be fully started. Verify it is fully started by opening the file6.
c:octomcatlogscatalina.out
and looking for this line:
INFO: Server Startup in XXXXX ms
Stop Tomcat. (See instructions, which are included at Start Tomcat.)7.
Wait about two minutes for Tomcat to stop, then delete the file8.
c:octomcatwebappsOpenClinca.war
Using WordPad, make any changes to the configuration file9.

Open the file1.
CATALINA_HOMEwebappsOpenClinicaWEB-INFclassesdatainfo.properties
Make changes to any values for the properties: see more information at Description of2.
datainfo.properties File.
When you finish making changes, save the file.3.

Move the backed up CRF and dataset files from the openclinica.data directory to the new10.
openclinica.data directory.
Start Tomcat. (See instructions at Start Tomcat.)11.

10.15.7 Back Up OpenClinica Web Services
Before upgrading, follow this process to back up the database and files needed by OpenClinica:

Stop Tomcat. (See instructions, which are included in Start Tomcat.)1.
Back up the database (instructions here).2.
Back up the file3.
CATALINA_HOMEwebappsOpenClinica-wsWEB-INFclassesdatainfo.properties
Back up the folder4.
CATALINA_HOMEwebappsOpenClinica-ws

10.15.8 Verify the Upgrade for OpenClinica
Web Services

Point your web browser to the OpenClinica Web Services welcome page: http://<<server1.
url>>:8080/OpenClinica-ws. The OpenClinica Web Services Welcome page should be display.
Verify the version number is v.x.x-Community, where v.x.x is the version number you upgraded2.
OpenClinica Web Services to. The version number is displayed in the lower right corner of the
page.

https://community.openclinica.com/project/openclinica
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Web Services should have the same version as OpenClinica application.

10.15.9 Upgrade OpenClinica Web Services
Run upgrade for OpenClinica Web Services only if you are currently using Web Services 

Undeploy OpenClinica Web Services:1.
Delete the directory1.
CATALINA_HOMEwebappsOpenClinica-ws
Delete the file2.
CATALINA_HOMEwebappsOpenClinica-ws.war if exists
Delete the directory3.
workCatalinalocalhostOpenClinica-ws

Create the following directory, if it does not already exist:2.
c:ocinstall
Download the OpenClinica software, OpenClinica-ws-v.x.x.zip, from the OpenClinica3.
website: https://community.openclinica.com/project/openclinica. To download the software,
use your free community account; you will be required to log in to the account to download the
OpenClinica software. If you do not have an account, you may get one here. 

After downloading the OpenClinica software, extract the files to:
c:ocinstall.
Copy the file4.
c:ocinstallOpenClinica-ws-v.x.xdistributionOpenClinica-ws.war
to
c:octomcatwebapps
Start Tomcat. (See instructions at Start Tomcat.)5.
In about five minutes, Tomcat will be fully started. Verify it is fully started by opening the file6.
c:octomcatlogscatalina.out
and looking for this line:
INFO: Server Startup in XXXXX ms
Stop Tomcat. (See instructions, which are included at Start Tomcat.)7.
Wait about two minutes for Tomcat to stop, then delete the file8.
c:octomcatwebappsOpenClinca-ws.war
Using WordPad, make any changes to the configuration file9.

Open the file1.
CATALINA_HOMEwebappsOpenClinica-wsWEB-INFclassesdatainfo.properties
Make changes to any values for the properties: see more information at Description of2.
datainfo.properties File.
When you finish making changes, save the file.3.

Start Tomcat. (See instructions at Start Tomcat.)10.

10.16 OpenClinica VM Image
The OpenClinica VM(Virtual Machine) with JUNO demo study image is an easy method to get
OpenClinica up and running quickly without going through the entire installation procedure. This
documentation applies to all current versions of OpenClinica.

Download OpenClinica Appliance (Virtual Machine) with JUNO demo study

https://community.openclinica.com/project/openclinica
https://www.openclinica.com/cas/login?service=https://community.openclinica.com/cas?destination=https://www.openclinica.com/
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https://docs.openclinica.com/3-1/installation/3-1-installation-install-3-1-x-linux/3-1-installation-installation-linux-download-installation-files/#content-title-4337#content-title-5457#content-title-5457#content-title-5457%20#content-title-5457#content-title-5457%20#content-title-4343%20#content-title-4343%20#content-title-4343%20#content-title-4343%20#content-title-5457%20
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This virtual machine is a self-contained image based off CentOS 6.8 (Linux) base server installation
with Postgres 9.5, Tomcat 7 from EPEL repository, Oracle JDK SE7U67 and OpenClinica. The default
password for root user is clinica.

Approved for publication by Warren Vandeventer. Signed on 2017-01-18 1:31PM

Not valid unless obtained from the OpenClinica document management system on the day of
use.

10.16.1 Installing and Using VirtualBox
The OpenClinica VM Image is under the Open Virtualization Archive (OVA) format known to work
well with free and open source VirtualBox.  We recommend using VirtualBox 5.0 or newer.

You can download Virtualbox from https://www.virtualbox.org/

Documentation and community support is readily available from the same website as well.

The following shows how to load the OpenClinica VM image in VirtualBox

Open VirtualBox.1.
Open "Import Appliance..." from the File menu.2.
Now browse to the location where you downloaded the ova file and select it and click "Open".3.
Once imported, you can press "Start" to start the OpenClinica virtual machine4.
Login using user name root and password clinica.  Find the ip address of the virtual machine5.
using ifconfig command inside the virtual machine.  If the network is not up (ping google.com
to find out). You might have to adjust your network settings (default is bridged) within
VirtualBox and run service network restart to restart your virtual machine network service. 
Confirm you have network running correctly before proceeding to the next step.
Security (it is highly recommended that you follow these steps immediately after first start):6.
- You should change and record the default password for system account "root" (login as root
and apply command "passwd")
- You should upgrade the base system immediately to install all security updates published
meanwhile. The base system is CentOS 6.8, so you need to run as root the command "yum -y
update"
Go to http://ip-address:8080/OpenClinica/ where ip-address should be replaced by the actual ip7.
address you found out using ifconfig in the previous step.
 You should be able to see the OpenClinica login page.  The JUNO study demo accounts are as8.
follows:

datamanager / password

crc_A / password

investigator_A / password

https://www.virtualbox.org/


10.17 Configuring an Oracle Database for
OpenClinica (Deprecated)
If you use OpenClinica with the Oracle database, follow these instructions to set up the database.
The instructions differ depending on the version of OpenClniica you are using.

Approved for publication by Ben Baumann. Signed on 2014-04-16 2:38PM

Not valid unless obtained from the OpenClinica document management system on the day of
use.

10.17.1 Set Up Oracle for OpenClinica
Versions Pre-3.1.2
Follow these instructions to configure an Oracle 10g database to run with OpenClinica versions 3.1
and 3.1.1.

Open a shell/command prompt window and change the current directory to the location of the1.
OpenClinica database files.
Ensure there is at least 512MB of disk space available at that location.2.
Start sqlplus:3.

Run1.
sqlplus sys as sysdba
When prompted for the password, enter the sys password.2.

At the SQL prompt, run the script to set up the database tablespace and database user4.
"clinica":

Run1.
@oracle_setup_db.sql
When the following prompts are display (shown below in bold), provide these values2.
(shown below in code font):

Specify Tablespace name for Clinica Data:
openclinica
Specify Tablespace type for Clinica Data (S/M/L):
L
(This specifies a tablespace size of Large, 512MB.)
DataFile Name (with exact path):
/usr/lib/oracle/xe/oradata/XE/OPENCLINICA01.DBF
(This is the default oradata directory for Linux; specify the full path to the oradata
directory on your system.)
Specify the wanted username for the OpenClinica oracle account:
clinica

Check spool_oracle_setup_db.txt for any errors.3.
Change the default password "clinica" to a secure password:5.

As the sysdba user, connect to your instance via sqlplus by running1.
sqlplus sys as sysdba



Run the following command, where PASSWORD is the new, secure password you are2.
sepcifying for the clinica database user:
alter user clinica identified by PASSWORD;

Start Tomcat, which will build the OpenClinica database within the tablespace.6.
After the tablespace is built, create indexes to help performance by running the following:7.

Connect to sqlplus as the clinica user by running:1.
sqlplus clinica/clinica
Run this script:2.
@performance.sql

10.17.2 Set Up Oracle for OpenClinica 3.1.2
or Above
Follow these instructions to configure an Oracle 10g database to run with OpenClinica versions
3.1.2 or above.

Open a shell/command prompt window and change the current directory to the location of the1.
OpenClinica database files.
Ensure there is at least 512MB of disk space available at that location.2.
Start sqlplus:3.

Run1.
sqlplus sys as sysdba
When prompted for the password, enter the sys password.2.

At the SQL prompt, run the script to create the tablespace:4.
Run1.
@create_ts.sql
When the following prompts display (shown below in bold), provide these values (shown2.
below in code font):

Specify Tablespace name for Clinica Data:
openclinica
Specify Tablespace type for Clinica Data (S/M/L):
L
(This specifies a tablespace size of Large, 512MB.)
DataFile Name (with exact path):
/usr/lib/oracle/xe/oradata/XE/OPENCLINICA01.DBF
(This is the default oradata directory for Linux; specify the full path to the oradata
directory on your system.)

At the SQL prompt, run the script to create the database user "clinica":5.
Run1.
@oracle_setup_db.sql
When the following prompts display (shown below in bold), provide these values (shown2.
below in code font):

Specify the Tablespace name you provided when you executed the create_ts.sql
script:
openclinica
Specify the wanted username for the OpenClinica oracle account:
clinica

Check spool_oracle_setup_db.txt for any errors.3.
Change the default password "clinica" to a secure password:6.



As the sysdba user, connect to your instance via sqlplus by running1.
sqlplus sys as sysdba
Run the following command, where PASSWORD is the new, secure password you are2.
sepcifying for the clinica database user:
alter user clinica identified by PASSWORD;

Start Tomcat, which will build the OpenClinica database within the tablespace.7.
After the tablespace is built, create indexes to help performance by running the following:8.

Connect to sqlplus as the clinica user by running1.
sqlplus clinica/clinica
Run this script:2.
@performance.sql

10.18 Operating System Installation
OpenClinica Enterprise is available either via a cloud hosted solution or a self hosted and managed
system. The base supported platform for self hosted customers is Red Hat Enterprise Linux (RHEL)
6.5 or above. RHEL is a commercially supported operating system and recommended for enterprise
customers. CentOS is a free rebuild for RHEL without commercial support and is available at
http://centos.org. For either, we highly recommend using the 64-bit version for best performance if
your hardware is capable of supporting that architecture.

RHEL 6.x installation guide is available at
https://access.redhat.com/site/documentation/en-US/Red_Hat_Enterprise_Linux/6/html/Installation_G
uide/. Using Kickstart is recommended if you prefer to automate the installation steps.
However,unless you are running a large number of deployments, the interactive installer is easier to
perform.

If you choose to use RHEL, we recommend selecting the "minimal" option in the package selection.
Refer to
https://access.redhat.com/site/documentation/en-US/Red_Hat_Enterprise_Linux/6/html/Installation_G
uide/s1-pkgselection-x86.html for more details. As noted in the installation guide, choosing this
option maximizes security and performance since it reduces the number of services running and the
number of updates required for maintaining the system. If you are using CentOS, the exact same
options are available there as well. The net installation method allows you to download a small
image and pull in packages on demand. Since an OpenClinica installation only requires a small
number of packages within the operating system, this can be far more efficient than downloading
the complete image. For CentOS, refer to
http://www.if-not-true-then-false.com/2011/centos-6-netinstall-network-installation/ for a detailed
guide on doing a net installation.

As an alternative in CentOS, you can download the minimal installation image at
http://wiki.centos.org/Manuals/ReleaseNotes/CentOSMinimalCD6.0. If you choose to download the
minimal image,  please note that the following core packages must be installed on the system for the
OpenClinica installation and maintenance.
     *  tar
     *  unzip
     *  vim-enhanced
     *  cronie
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